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Live Services Management

NetWitness Live is the gateway to a rich environment that offers access to feeds, tools, and other
resources.

NetWitness Live

Live is the component of NetWitness that manages communication and synchronization between
NetWitness services and a library of Live content available to NetWitness customers. Live provides a
simple interface for browsing, selecting, and deploying content from the NetWitness Live Content
Management System to NetWitness services and software. In addition to managing feeds from the CMS
Library, Live allows users to deploy custom feeds and packages.

Note: Any customer with valid maintenance can access NetWitness Live.

The content management system (CMS) library (known as Live) is a valuable source of the latest
internet security resources for NetWitness customers. It provides a view into the collective intelligence
and analytical skills of the worldwide security community to ensure that users have the most current
visibility into attack vectors.

Live gathers the best advanced threat intelligence and content in the global security community - the
ideas, research, ongoing tracking, and analysis - and brings it directly into the user’s security operations
center to definitively classify computers associated with botnets, malware, and other malicious exploits.
Live aggregates, consolidates, and illuminates only the most pertinent information relevant to an
organization on a real-time basis.

NetWitness Feedback and Data Sharing

Live Feedback is intended to help improve NetWitness. Once you set up and configure a Live account,
usage data is shared with RSA.

For more details, see NetWitness Feedback and Data Sharing.

For Debian Linux and NetWitness Endpoint Users

If you are upgrading to NetWitness 11.5 or later, and you are using NetWitness Endpoint and also have
any Debian Linux endpoint systems, NetWitness recommends that you go to Live and download the
following application rules:

 autorun debian package mismatch

 autorun file path not part of debian package

e debian package hash mismatch in important system directory

* debian package hash mismatch

« file path not part of debian package in important system directory
e file path not part of debian package
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Deploy Content

This section explains the different ways available to deploy content:

e Deploy Content using Live Content Ul

e Centrally Deploy Content using Policy Ul

Deploy Content 7
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Create Live Account

Note: The NetWitness Live Registration Portal now has a new user interface and supports email
verification.

You must create a Live account using the NetWitness Live Registration Portal
(https://live.netwitness.com/registration/) on the Live server. Live Account is required to access all Live
services including CMS. The CMS Library provides access to all NetWitness content in one place where
you can view, search, deploy, and subscribe to NetWitness content.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Make sure the following are available to set up a NetWitness Live account:

e Active internet connection to access the portal.
e A valid and registered NetWitness License Server on the Flexera Server, before you can register for a

a4
Live account. You can view the License ID on the (Admin) > System > Info panel.

Note: If the License Server is not set up, contact NetWitness Customer Support.

To create a Live Account:

1. Access the NetWitness XDR Cloud Services Live Registration Portal using
the URL: https://live.netwitness.com/registration/

The NetWitness XDR Cloud Services Live sign up page is displayed.

8 Deploy Content
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NETWITNESS

Sign in with your username and password

Password *

Username *

SIGN IN SIGN UP FORLIVE

2. Click Sign Up For Live.
The End User License Agreement page is displayed.
Read the Terms and Conditions carefully and click Accept.

Welcome to RSA Live Registration Portal

Thank you for using RSA NetWitness.
Please sign up here for your RSA Live account to access your subscription content.

End User License Agreement

THIS SOFTWARE CONTAINS COMPUTER PROGRAMS AND OTHER PROPRIETARY
MATERIAL AND INFORMATION, THE USE OF WHICH IS SUBJECT TO AND EXPRESSLY
CONDITIONED UPON ACCEPTANCE OF THIS END USER LICENSE AGREEMENT (THE
“AGREEMENT").

THIS AGREEMENT IS A LEGALLY BINDING DOCUMENT BETWEEN YOU (MEANING
THE INDIVIDUAL PERSON OR THE ENTITY THAT THE INDIVIDUAL REPRESENTS
THAT HAS OBTAINED THE SOFTWARE AND HARDWARE FOR ITS INTERNAL
PRODUCTIVE USE AND NOT FOR OUTRIGHT RESALE) (THE “CUSTOMER”) AND
NETWITNESS (WHICH MEANS (1) RSA SECURITY LLC, IF CUSTOMER IS LOCATED IN
THE UNITED STATES, MEXICO OR SOUTH AMERICA; (ll) THE LOCAL NETWITNESS
SALES AFFILIATE, IF CUSTOMER IS LOCATED OUTSIDE THE UNITED STATES, MEXICO
OR SOUTH AMERICA AND IN A COUNTRY IN WHICH NETWITNESS HAS A LOCAL
SALES AFFILIATE; OR (Ill) RSA SECURITY & RISK IRELAND LIMITED OR OTHER
AUTHORIZED NETWITNESS ENTITY AS IDENTIFIED ON THE NETWITNESS QUOTE
OR OTHER NETWITNESS ORDERING DOCUMENT, IF CUSTOMER IS LOCATED

OUTSIDE THE UNITED STATES, MEXICO OR SOUTH AMERICA AND IN A COUNTRY IN
WHICH NETWITNESS DOES NOT HAVE A LOCAL SALES AFFILIATE). Unless
NetWitness agrees otherwise in writing, this Agreement governs Customer's use of the
Software and Hardware, except to the extent all or any portion of the Software or
Hardware is: (a) the subject of a separate written agreement set forth in a quotation

ACCEPT

3. In the Sign Up for NetWitness Live Account page, enter all the fields:
¢ The First Name and Last Name of the user.
¢ The Company for which the Live Account is being created.
¢ The Email address you enter will be used to receive the verification code for your new Live

account and other notifications related to the Live account.

The License ID can be viewed on Kl (Admin) > System > Info panel.

Deploy Content 9
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¢ The Username and Password for the Live Account.

NETWITNESS

Sign Up for Netwitness Live Account e

Company

First Name

Last Name

License ID
Username

Password

CREATE ACCOUNT

4. Click Create Account.
You will be directed to Confirm Sign up page.

5. Enter the Confirmation Code sent to your registered email address.
Click Confirm.
You can see the confirmation message for your NetWitness Live Account registration.

Note: You cannot create more than one Live account for the same License ID. For additional
license, contact NetWitness Customer Support.

6. Once the account is created, enter your credentials and click Sign In to access the NetWitness XDR
Cloud Services Live.

7. After you sign in, you can perform the following:

e Search and Download Content from NetWitness XDR Cloud Services Live

¢ Share Telemetry Data to NetWitness

10 Deploy Content
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Reset the Password for Your Live Account

If you want to reset the password for your Live Account, do the following:

1. Access the NetWitness XDR Cloud Services Live Registration Portal using the URL:
https://live.netwitness.com/registration

The NetWitness XDR Cloud Services Live sign up page is displayed.

NETWITNESS

Sign in with your username and password

Username *

Password *

SIGN IN SIGN UP FOR LIVE

2. On the Sign Up page, click Forgot Password?.

3. Enter your Username and click Send Code.
A verification code will be sent to your registered email address.

4. Enter the Verification Code and New Password on the Reset Password page and click Submit.

Deploy Content 11
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Set Up Live Services on NetWitness Platform XDR

To set up Live on NetWitness Platform XDR, you configure the connection and synchronization between

4
the CMS server and NetWitness. The user interface for this setup is the (Admin) > System > Live
Services Configuration panel.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

To configure the connection to the CMS Server:

Q
1. Navigate to (Admin) > System > Live Services.

2. Click Sign In and enter your credentials in the Live Services Account dialog box.

Live Services Account

cms.netwitness.com

Port 443
55l 4
Username admin
Password S T T T TS

Test Connection

3. Click Test Connection to make sure your connection is working.

12 Deploy Content
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4. If the test is successful, click Apply. If not, contact NetWitness Customer Support for help
connecting to the Live server.

5. Configure the timing for synchronization of NetWitness Platform XDR with updates from Cloud
Services Live.

For more details, see the "Configure Live Services Settings" topic in the System Configuration Guide.

Deploy Content 13
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Deploy Content using Live Content Ul

This topic explains the process of deploying the content using Live Content UI.

e Live Services Required Procedures

e Additional Procedures

e References

e Troubleshooting Live Services

14 Deploy Content
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Live Services Required Procedures

The following workflow describes the basic setup into four steps, which you perform individually.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

Search/Download
Live Content

Configuration Step

Create Live Account

Set Up Live Services on NetWitness
Platform XDR

Find and Deploy Live Resources

Manage Live Resources

Search and Download Content from
NetWitness XDR Cloud Services Live

NetWitness Feedback and Data
Sharing

(Optional)
Configure Feedback
& Data Sharing

Create a Live Account on the Cloud Services Live
Registration portal
URL: https://live.netwitness.com/registration/.

Set Up Live Services on NetWitness Platform XDR by
configuring a connection with the CMS server.

Search and browse for resources in the Live Search view, and
then, deploy the selected resources.

Procedures for administrators to search for, subscribe to, and
deploy resources from Live.

Search and browse for content in the Cloud Services Live,
and then, download the selected content.

Describes the feedback and data sharing features provided in
NetWitness, from Live Services. Participation is optional, but
can help to provide useful threat intelligence for the
community.

Deploy Content
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Find and Deploy Live Resources

Administrators can search for resources in the Live Search view, which is also the same as browsing the
Live CMS for resources using the Search Criteria panel of the Live Search View.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
. Configure Feedback
Live Content & Data Sharing

Search/Download

Find Resources in Live

IMPORTANT: ESA Rules cannot be deployed manually via Live Services. By default, all the ESA
rules are available in the ESA Rule library if Live Service is configured.

To find resources:

1. Navigate to (Configure) > Live Content.

2. In the Search Criteria panel, specify search criteria. Enter any or all of these: keyword, category,
type of resource, medium, meta keys, meta values, date resource was created, and date resource was

modified.
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Search Criteria

Keywords

Category
CIFEATURED

» CITHREAT

» CJIDENTITY

» ] ASSURANCE

» ] OPERATIONS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:

3. Click Search.
The Matching Resources panel displays detailed results.

4. (Optional) To further narrow the results In the Matching Resources panel, click on a tag, meta key,
medium or resource meta value in a result.

Deploy Resources in Live

In NetWitness, you can deploy selected resources manually, using the Deployment Wizard, or you can
subscribe to a group of resources.

e When you have results from browsing resources in NetWitness Live, you can deploy resources

manually to a service or a service group without subscribing to the resources. To deploy resources,
select one or more from the list.

* Deploying resources manually deploys to services without taking advantage of the powerful resource
management capabilities of NetWitness. If you want to receive notification and updates for updated
resources and be able to easily remove resources from a service, you must subscribe to resources in
the Live Search view and deploy them in the Live Configure View.

» If you have previously created and saved a resource package, you can deploy the package to services.
Please refer to Resource Package Deployment Wizard for instructions on how to create a package.

Caution: For NetWitness 11.3, there is a new Content bundle for Endpoint, which contains
approximately 400 application rules. Do not deploy this bundle (or the Endpoint application rules) onto
any Log Decoder that is running an earlier version of NetWitness. The rules are only useful for 11.3
and newer, and would have major performance implications if deployed on Log Decoders that cannot
process them.

Deploy Content 17
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To deploy resources manually:

1. Goto (Configure) > Live Content.
2. Select a group of resources, or a previously created resource package.

To select a resource or group of resources:

a. In the Live Search View, browse Live resources (for example, search for the Log Collector
resource Type).

b. In the Matching Resources panel, select Show Results > Grid.

c. Select the checkbox to the left of the resources that you want to deploy.

d. In the Matching Resources toolbar, click .F, Deploy

Deployment Wizard

Resources Services Review

Total resources: 2

Resource Names Resource Type Dependency of
Symantec Critical Systems Protection Log Colle..  Log Collector
AWS CloudTrail Log Collector Configuration Log Collector

Cancel Next

3. To select a resource package to deploy:
a. In the Live Search view - Matching Resources toolbar, select Package > Deploy .

The Package page of the Resource Package Deployment wizard is displayed.

18 Deploy Content
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Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel Next

b. Click Browse and select a package from your network (for example resourceBundle-
FeedsParsersContent.zip).

c. Click Open.

At this point, whether you are deploying a package or a group of resources, the Deployment
Wizard opens, and the Resources page is displayed.

4. Click Next.
The Services page displayed has two tabs, Services and Groups, which provide a list of services and

4
service groups that are configured in the (Admin) > Services view. The columns are a subset of
the columns available in the Services view.

Note: The Live server is "smart" about deploying resources to Services. For example, it does not
deploy resources that have a Medium of packets to any Log Decoders. This means that only
applicable content resources are deployed to each Service.

5. Select the services on which you want to deploy the content. You can select any combination of
services and service groups.

¢ Use the Services tab to select individual services, list of services, and service groups that are
configured in the KZ4:M (Admin) > Services view.

¢ Use the Groups tab to select groups of services.

Deploy Content 19



Live Services Management Guide

Deployment Wizard

Resources Services Review Deploy
(| ﬁ MName ~ Type
[l # UlEndpoint Other

Cancel Previous Next
6. Click Next.
The Review page is displayed.
Deployment Wizard
Resources Services Deploy
Service Service Type Resource Name Resource Type
Ul Endpoint NW Local Basic Rule Template RSA Event Stream Analy...
Cancel Previous Deploy
Make sure that you have selected correct resources and the services on which you want to deploy
them.
7. Click Deploy.
The Deploy page is displayed. The Progress bar turns green when you have successfully deployed
the resources to the selected services.
20 Deploy Content
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Deployment Wizard

Resources Services Review

Live deployment task finished successfully

Service Name Resource Name Status Progress

Ul Endpoint Basic Rule Template 10f1 ‘ y

Close

If you try to deploy resources and services that are not compatible, NetWitness displays the Errors
and Retry buttons, which you can click to review the errors and re-attempt the deployment.

Package Resources Devices Review

Deployment in progress...
Device Name Resource Name Status Progress
Log Decoder4  Malware Domains 3of3 e ———

8. Click Close.
Next steps

After deploying parsers to Decoders and Log Decoders, you must enable parsers on the individual
services. For more information, see the Decoder and Log Decoder Configuration Guide.

Deploy Content 21
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Manage Live Resources

With a connection to the CMS server, you can search for, subscribe to, and deploy resources from Live
in accordance with your subscription level. Once you have found resources, you deploy them to services

A
and service groups that have been configured in the the (Admin) > Services view.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

There are several workflows for deploying resources to services and managing those deployments. These
include:

* Subscribe and deploy resources

* Deploy a resource bundle

* Remove deployments of resources
* Download resources

* Set up data feeds

Manage Subscription and Deployment

The subscription and deployment workflow takes advantage of the resource management tools available
in Live. By subscribing to resources, you agree to receive updated resources in accordance with the

4
synchronization configured in the (Admin) > System > Live Services panel.

By adding subscribed resources to the deployments list, you configure NetWitness to automatically push
those resources to the selected services at the configured synchronization intervals. This method requires
some planning of service groups and services where resources are deployed. In addition:

* You can remove a resource from the deployments list in the Deployments Tab.

* You can unsubscribe from a resource in the Subscriptions Tab and the Live Resource View.
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To manage subscriptions and deployment:

Q
1. Inthe (Admin) > System > Live Services panel, specify an interval at which NetWitness
checks for updates to subscribed resources in Live and specify the email addresses of people to
receive an email listing subscribed resources that have been updated.

2. Inthe (Configure) > Live Content search view, search for and subscribe to Live resources.

3. Inthe (Configure) > Subscriptions > Deployments tab, select subscribed resources and add
them to the deployment list for services groups.

* to deploy the

=

4. (Optional) In the (Configure) > Subscriptions > Deployments tab, click *
resources listed in the Deployments tab immediately.

5. In the (Configure) > Subscriptions > Deployments tab, select deployed resources from a
Group, and remove them from services.

6. In the (Configure) > Subscriptions tab, unsubscribe from resources.

Remove a Deployed Resource

Once deployed to a service, Live resources remain on the service until removed. It is a good practice to
remove unused resources from services on which they are deployed.

To remove deployed resources:

1. Go to the Live Resource View

2. Unsubscribe from a resource, and remove it from deployed services.

Deploy a Resource Bundle

To deploy a content package, use the Resource Package Deployment Wizard. You can deploy a content
package created in Live to one or more services. NetWitness accepts packages in .nwp files or .zip files.

Download Resources

To download resources to your local file system, use the Download button in the Live Resource view.

Set Up Data Feeds

In the Live > Feeds view, you can set up and maintain Custom and Identify feeds.
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Search and Download Content from NetWitness XDR Cloud Services Live

Administrators can search for live content using the Search Content panel in the NetWitness XDR Cloud

Services Live, which is similar to browsing the live CMS content in the (Configure) > Live Content
page on the NetWitness Platform XDR.

Note: If Admin server is not connected to the Live Services, you can use the NetWitness XDR Cloud
Services Live to search and download the required content.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

Search/Download ‘(Optlonal)
i Configure Feedback
Live Content

& Data Sharing

Prerequisites

e Ensure that you have created the Live account. For more information, see Create Live Account.

Quick Search for Content

You can now select and view the content based on the Sources available in the Cloud Services Live. You
can select either NetWitness or Community from the Source drop-down list.

o NetWitness: Displays all the content provided by NetWitness.

¢ Community: Displays the content collected and retrieved from third party and open source
communities.

Note: The Only Opensource option will appear under the Search Content panel only when the

community is selected as the source. You can use this option to select and search open-source
related content.

You can also quickly select and view the available content types under Content section.

Clicking ] expands the Content section and displays the following options:
o New: Displays the content which is created in the last 21 days.

* Recently Updated: Displays the content which is created or updated in the last 21 days.

24 Deploy Content




Live Services Management Guide

Advanced Search for Content

You can search for the specific content in the Search Content view. For more information, see Live

Search Content View.

To search the content:

1. Click B to expand the Search Content section.

2. In the Search Content, specify the search criteria. Enter any or all of these: keyword, type of
resource, medium, tag, platform versions, meta keys, meta values, date when content was created,
date when content was modified, and (optional) discontinued content.

SOURCE : Community

Only Opensource

Content

Search Content

KEYWORDS

RESOURCE TYPES

MEDIUMS

TAGS

new

PLATFORM VERSIONS

11.5.0.0

REQUIRED META KEYS

GENERATED META VALUES

CREATED DATE

2022-08-16

MODIFIED DATE

2022-09-06

» Include Discontinued

3. Click Search.

The matching results are displayed on the right panel.

Reset Filter

Deploy Content
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& Content

View Ne ecently updated and community content details here.

Showing Filtered Content (877) Timezone : GMT+0530 Asia/Calcutta
NAME 3 CREATED * UPDATED 4 TYPE 4 MIN PLATFORM VERSION 4 DESCRIPTION 4 DISCONTINUED *

11-Sep-202001:2... 17-Jul-2022 10:01... Feed Al Versions This feed contains IP Address (IPv4 and IPvé) indicators that a... No
26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11.5.00 This dashboard provides information on various NetWitness P... No
26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11500 This dashboard provides information on NetWitness Platform... No
11-Sep-202001:2... 17-Jul-2022 10:01... Feed Al Versions This feed contains Non-IP Address, text based indicators like ... No
26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.00 Amount of Incoming UDP Packets Requested by Endpoint ser... No
26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11.5.0.0 Capture is not started on this Decoder service, so packet data... No
06-Aug-2020 20:5... 13-Aug-202 5 Application Rule 11.5.00 Ahash mismatch may indicate a file has been altered fromits o... No
23-Dec-2020 16:4... 23-Dec-2020 16:4... Log Device 11.5.0.0 Log device content for event source AWS Route53 Resolver -...

19-Mar-202119:3... 19-Mar-202119:3... Log Device 11500 Log device content for event source Cisco Umbrella - cisco_um...

26-Nov-2020 16:2... 26-Nov-2020 16:2... Not found 11.5.00 Reporting Engine home directory /var/netwitness/re-server/r...

26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11.5.0.0 80% of the Contexthub Server's query response cache is in use.

26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.0.0 Decoder is presently not capturing data.

You can sort the content using the name, created, updated, type, or any of the column.

Note: Clicking Reset Filter removes the existing filters applied from the Search Content, and
displays all the available content on the right panel.

Download Content

You can download the content from the results displayed in the right panel by performing the following
steps:

Note:

- You cannot download a discontinued content.

- NetWitness provides no assurance related to the quality and accuracy of the content provided by the
third parties and open source communities.

To download the raw content:
1. Click the name of the content that you want to download.

The Content Details dialog is displayed.
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Content Details

NOTE: The following content s collected and derived from third-party, open sources. RSA
o [NetWitness] at no times makes claims to the quality and/or efficacy above and beyond the
attestations of the authors of the content itself.

[Community] Malware, Malicious Code and APT Open Source YARA
Rules

TYPE

A

UPDATED

@ Large files may take longer time to start the download.

2. Click Download.

The content file is downloaded.

To download the one or more content:

1. Log in to the NetWitness XDR Cloud Services using your Live account credentials.
URL: https://live.netwitness.com/registration.

2. Select one or more content you want to download and click Generate Content Package.
A Multiple Content Download dialog is displayed.

3. Ifrequired, select the Include Dependencies checkbox to include dependencies for the selected
content. You can change the default package name as required.

4. Click Generate Package Link.
NetWitness XDR Cloud Services begins the content package (tar.gz file) creation.

Multiple Content Download

The NetWitness Live will create a content package (tar.gz file) to include your selected
content.

A link to download the content package will be available on the Package Downloads
page. The downloaded folder includes tag metadata, medium metadata, contents

metadata, and raw contents.

Include Dependencies

PACKAGE NAME

Package Name 17-Feb-2023 13:20:37

Change the package name if required.

Cancel Generate Package Link
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27


https://live.netwitness.com/registration

Live Services Management Guide

5. Go to the (Package Downloads) page and click Download to download the respective

package.

NETWITNESS

v, Package Downloads

erated links. Links lasts upto 14days from date of creation.

PACKAGE CONTENT & TOTAL CONTENT 4 size
package-1675665045392 2.37MB
package-1675322481017 391KB

17.71KB

EXPIRY DATE & CREATED + STATUS &

06-Feb-2023 (in 14 days) 06-Feb-2023 12:00:46

02-Feb-2023 (in 10 days) 02-Feb-202312:51:21

01-Feb-2023 (in 9 days) 01-Feb-2023 17:21:32

The downloaded folder includes tag metadata, medium metadata, contents metadata, and raw
contents. You must extract (unzip) the content package, select each of the raw content files and
upload it to the appropriate devices or services on NetWitness Platform XDR.

28
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Additional Procedures

This topic explains the additional procedures an administrator could choose to follow which are not
essential for the configuration or use of Live Services.

e Export Data to RSA

e Packaging Resources

e Manage Custom Feeds

¢ Creating a Custom Feed

¢ Create a STIX Custom Feed

¢ Creating and Managing an Identity Feed

Editing a Feed

e Removing a Feed

e Miscellaneous Live Services Procedures
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Export Data to RSA

A NetWitness administrator can export the metrics in NetWitness for Live Feedback.

About Live Feedback

In the Live Services Configuration panel, there is a Live Feedback Activity Log which enables you to
download the usage data required for Live Feedback. This is active regardless of the Live
Account configuration.

If the Live Account is not configured, you can manually upload the usage data to RSA. For more
information, see the "Configure Live Services Panel" topic in the System Configuration Guide.

You must first download the Live Feedback historical data, and then upload it to share with RSA.

Download Live Feedback Historical Data

To download the Live Feedback historical data:

A
1. Goto (Admin) > System.
2. In the options panel, select Live Services.

The Live Account screen is displayed which consists of the RSA Live Status and Download Live
Feedback Activity Log.

3. Click Live Feedback Activity Log.

The Live Feedback Activity Log window opens which allows you to download the required Live
Feedback historical data.

Live Feedback Activity Logs

Download monthly anonymized activity logs and manually upload to R5A secure portal,

For use only when live account is not configured.

L pate Range Last Download Date

[0 2017, June30-18

| Page |1 | of1 | | C PageSize 10 ~ Displaying 1 -1 of 1

Close

4. Select one or multiple entries by selecting the checkboxes and click Download.

Note: If you select multiple entries in the history table, the Live Feedback data is downloaded into
a ZIP archive, consisting of individual JSON files for each month.

Share Telemetry Data to NetWitness

After you download the Live Feedback data, you can then upload it using the following procedure.
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Note:

- To download the Live Feedback data, see topic Download Live Feedback Historical Data.

- You can share data through NetWitness XDR Cloud Services Live portal. For more information,
Create Live Account.

To share the data to NetWitness
1. Log in to the NetWitness XDR Cloud Services using your Live account credentials.

2. Click on the left panel.
The Telemetry Logs dialog is displayed.

L Telemetry Logs

Upload Live Feedback Activity Logs.

Click or drag-and-drop the .zip file to upload.

Note:
- You can upload only .zip files.
- Filename must be 255 characters or less and file size must be less than 128 MB.

3. Click or drag-and-drop a file onto this area to upload.
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Packaging Resources

The primary use for creating and subsequently deploying a resource package is for customers using an
air gap network environment. In this case, you create a resource package on the network that is
connected to the internet, and then deploy the resource package on a more secure network.

Create and Deploy Resource Package Use Case

The basic steps are as follows:
1. Access NetWitness Live Services using an instance that is connected to the internet.
2. Create a Resource package as described below, adding whichever content items you need.

3. Copy the ZIP archive of the packages to your secure NetWitness instance, by using a thumb drive or
other manual copying process.

4. On the secure NetWitness instance, deploy the resource package. For more information, see Resource
Package Deployment Wizard.

Prerequisites to Create a Resource Package

A prerequisite for creating resource packages is configuration of the connection and synchronization
between the CMS server and NetWitness and the ability to search for resources in the User Interface.

Creating a Resource Package

The following procedure describes how to create a resource package, as a ZIP archive and save it to your
local file system.

To create a resource package:

1. Goto (Configure) > Live Content from the NetWitness UI.

2. Select the resources that you want to package in the Matching Resources grid.
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NETWITNESS

LIVE CONTENT

Search Criteria

Keywords

Category
[CJ FEATURED
» CITHREAT
» CJIDENTITY
» CJASSURANCE
» [T OPERATIONS
[JsPecTRUM

[ MALWARE ANALYSIS

Resource Types
Medium

Required Meta Keys
Generated Meta Values

Resource Created Date:

Start Date

Resource Modified Date:

SUBSCRIPTIONS

End Date

Investigate

v

CAPTURE POLICIES

Respond Users

POLICIES

Matching Resources
5 Show Results |

Subscribed Name

no RSA OSINT IP Threat Intel F...
1 no RSA OSINT Non-IP Threat In...
I no Powershell Runs Command...
¥ no Runs ACL Management T...
¥ no AWS Security Hub Log Col...
O no NWFL_fw:outbound-networ...
[ no 15027002 - Compliance Rep...
no Direct Login By A Watchlist ...
no 11.3 Endpoint Indicators by...
no RSA Certificate Manager Lo...
no Top Outbound Source IP
no Runs Chained Command S...
no Enumerates Local Groups
no SecurlD Cloud Device Regis...
no File Transport over ICMP
J no fingerprint_job
[ no Cisco Ironport ESA Log Coll...
O no HyTrust
O no Bit9 Log Collector Configur...
no Event Viewer Executes Unc...
no Microsoft Audit Collection S...

663 Matching Resources

Hosts

INCIDENT RULES

"8 Deploy

Files Dashboard

A Subscribe

Created

2020-09-10 7:53 PM
2020-09-10 7:53 PM
2019-04-10 2:23 PM
2019-04-10 2:29 PM
2020-07-28 6:17 PM
2012-04-23 12:09 PM
2014-06-17 2:45 PM
2018-03-27 2:01 PM
2019-04-10 1:51 PM
2013-11-22 6:35 AM
2014-07-24 10:56 AM
2019-04-10 2:30 PM
2019-04-10 2:16 PM
2019-04-17 5:54 AM
2014-07-21 5:31 PM
2013-09-12 2:24 PM
2013-11-22 6:13 AM
2014-02-14 3:34 AM
2013-11-226:11 AM
2019-04-10 2:17 PM

2014-02-14 3:41 AM

Reports

INCIDENT NOTIFICATIONS

K Package

Updated

2022-09-06 4:30 AM
2022-09-06 4:30 AM
2020-01-23 4:21 PM
2019-04-10 3:09 PM
2020-07-29 7:52 AM
2017-11-11 3:37 AM
2017-09-23 5:41 AM
2018-07-24 5:31 PM
2019-04-10 2:02 PM
2017-09-13 11:40 AM
2017-09-23 5:49 AM
2019-04-10 3:10 PM
2019-04-10 3:06 PM
2019-04-17 5:56 AM
2017-11-11 3:37 AM
2017-09-23 5:37 AM
2017-09-13 11:37 AM
2017-09-13 11:07 AM
2017-09-13 11:37 AM
2019-04-10 3:07 PM

2020-05-04 2:06 PM

ESA RULES

Type

Feed

Feed

Application Rule
Application Rule
Log Collector
Application Rule

NetWitness Report

Event Stream Anal...

NetWitness Rule
Log Collector
NetWitness Rule
Application Rule
Application Rule
Application Rule
Application Rule
Lua Parser

Log Collector
Log Device

Log Collector
Application Rule

Log Device

3. Select some or all the resources that are listed in the Matches Resources pane.

4. Select # Package

> Create.

admin v

CUSTOM FEEDS

Description
This feed contains IP Address (IPv
This feed contains Non-IP Addres
Powershell running command pr
Running ACL management tool
Log Collector configuration con
NWFL App Rule to support Inforn
1SO 27002 establishes guidelines
A successful interactive or remote
Number of risk indicators associe
Log Collector configuration conte
Summarizes a list of outbound sc
Running chained command shell
Enumeration of local groups can
Raises an alert when RSA SecurlC
Detects files transported over ICh
Identifies windows job task schec
Log Collector configuration conte
Log device content for event sour
Log Collector configuration conte
Event viewer executing uncommc

Log device content for event sour ¥
»

NetWitness creates a .zip archive that contains the selected resources and downloads it to your default
download folder. NetWitness gives the package a generic name. You should rename it when you save it
so that it identifies the resources contained in the package.

Creating Threat Package

The following procedure describes how to create a resource package that contains all the content that is
categorized as Threat. Then we rename it, using the type of content and date.

1. Goto

(Configure) > Live Content.

2. From the Category section, select Threat.

3. Select all items returned by clicking on the checkbox in the column header row of the Matching

Resources pane.
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS
Search Criteria Matching Resources
Keywords [ Show Results = | "8 Deploy | 3 Package
¥ Jname Created Updated Type Description
Category ¥ Local or Guest User Acco...  2022-05-27 11:28 AM 2022-05-27 11:28 AM Application Rule This rule triggers when a Local or Guest us
[CIFEATURED ¥ Clears Application Event ...  2021-10-11 2:41 PM 2021-10-11 2:41 PM Application Rule Tampering with windows event logging car
4 THREAT ¥ Deletes Shadow Volume... ~ 2021-10-11 2:40 PM 2021-10-11 2:40 PM Application Rule Deleting shadow volume copies can be an i
» [ Attack Phase ¥ Runs Regsvcs or Regasm 2022-03-08 1:40 PM 2022-03-08 1:40 PM Application Rule Regsvcs and Regasm are digitally signed W
» O Malware ¥ Enumerates Network Co...  2022-06-02 8:11 AM 2022-06-02 8:11 AM Application Rule ion of network jons can t
» CJIDENTITY [¥ Potential Abuse of Net Ut... 2022-06-02 8:12 AM 2022-06-02 8:12 AM Application Rule Net has a great deal of functionality, much
» CIASSURANCE ¥ Follina Command Executi... 2022-06-02 9:33 AM 2022-08-16 11:18 AM Application Rule This rule looks for command line argumen
» [ OPERATIONS [¥/ Suspicious MSDT Parent P... 2022-08-16 7:04 PM 2022-08-16 7:04 PM Application Rule During exploitation of CVE-2022-30190 (Foll
[ SPECTRUM [V Changes to GPO or Group... 2022-07-28 7:54 AM 2022-07-28 7:54 AM Application Rule This rule detects when any changes are m:
[ MALWARE ANALYSIS Disables Windows Defend... 2019-04-10 2:15 PM 2021-10-11 2:37 PM Application Rule Disabling windows defender using powerst
[¥ Domain User Account Cre... 2022-05-27 11:29 AM 2022-05-27 11:29 AM Application Rule This rule detects when a new domain user
Resource Types =
v/ Possible Impacket Host A...  2022-03-29 7:37 PM 2022-06-21 6:19 PM Application Rule Detect possible Impacket psexec usage on
[¥ Potential Abuse of COM ... 2022-06-09 4:49 PM 2022-06-09 4:49 PM Application Rule Adversaries may establish persistence by e
Medium v/ [Community] Possible Qa...  2022-03-24 5:19 PM 2022-06-29 1:54 PM Application Rule Once on a victim host, Qakbot performs se
v ¥ [Community] Nerbian RA...  2022-06-30 1:34 PM 2022-06-30 1:34 PM Application Rule Following rule helps to detect known techr
v | ¥ Unexpected fodhelper.ex...  2022-08-25 11:15 AM 2022-08-25 11:15 AM Application Rule fodhelper (Features On Demand Helper) is ¥
»
Search .
- 320 Matching Resources

4. Select * Packagze © > Create.

A ZIP archive is saved to your Downloads folder. For example,
resourceBundle8740753704980701969.zip.

5. Rename the package to something meaningful. For example, in this case, you cold change the
package name to threatResourceBundle 2018 01 31.zip (assuming today's date is January 31,
2018).

The resource package is now available for later deployment.

Deploying a Threat Package

This procedure assumes that you saved a package named threatResourceBundle 2018 01 31.zip, as
described in the previous section. It describes how to deploy a saved resource package

1. Goto . (Configure) > Live Content.

2. In the Matching Resources pane, select A Package © > Deploy.
3. Click Browse and navigate to the threatResourceBundle 2018 01_31.zip file that were created

earlier.
Resource Package Deployment
Package Resources Services Review Deploy
Resource Bundle |threatResourceBundle_2018_01_31.zip Browse

Cancel Next

4. Click Next.
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The Resources page displays details for the resources in the package.
5. Click Next.
The Services page displays two tabs, Services and Groups, which provide a list of services and

4
service groups that are configured in the (Admin) > Services view. The columns are a subset of
the columns available in the Services view.

6. Select the services on which you want to deploy the content. You can select any combination of
services and service groups.

Deployment Wizard

Resources Services Review Deploy

& Name ~ Type
& UlEndpaint Other

Cancel Previous Next

7. Click Next.
The Review page is displayed.

Note: Make sure that you have selected correct resources and the services to which you want to
deploy them.

8. Click Deploy to complete the deployment process. Alternatively, you can choose Cancel or Previous
to either cancel the deployment or go back to the previous screen.
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Manage Custom Feeds

The custom feed capability is implemented using the Custom Feed Wizard in NetWitness, allowing you
to quickly populate Decoders with custom and identity feeds.

Custom Feed Creation

You can use the Live > Custom Feeds > Setup Feed > Configure a Custom Feed wizard to create and
deploy Decoder feeds based on deterministic logic that offers the meta keys specific to the selected
Decoders and Log Decoders. Although the wizard guides you through the process to create both on-
demand and recurring feeds, you should understand the form and content of a feed file when you create a
feed.

Feed file names in NetWitness are in the form <filename>. feed. To create a feed, NetWitness
requires a feed data file in .csv or .xm1 (for STIX) format and a feed definition file in . xm1 format,
which describes the structure of a feed data file. The Configure a Custom Feed wizard can create the
feed definition file based on a feed data file, or based on a feed data file and the corresponding feed
definition file.

The files that you use to create an on-demand feed must be stored on your local file system. The files
used to create a recurring feed must be stored at an accessible URL, whence NetWitness can fetch the
most current version of the file for each recurrence. After a NetWitness feed is created, you can
download the feed to your local file system, edit the feed files, and edit the NetWitness feed to use the
updated feed files.

Sample Feed Definition File

This is an example of a feed definition file named dynamic_dns.xml, which NetWitness creates based
on your entries in the Feed wizards. It defines the structure of the feed data file named dynamic
dns.csv.

Note: The feed file path should be . csv regardless of the Feed Type (Default or STIX).

Sample Feed Definition File

<FDF xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="feed-definitions.xsd">
<FlatFileFeed name="Dynamic DNS Domain Feed"
path="dynamic_dns.csv"
separator=","
comment="4#"

version="1">

<MetaCallback
name="alias.host"
valuetype="Text"
apptype="0"
truncdomain="true"/>

<LanguageKeys>
<LanguageKey name="threat.source" valuetype="Text" />
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<LanguageKey name="threat.category" valuetype="Text" />
<LanguageKey name="threat.desc" valuetype="Text" />
</LanguageKeys>

<Fields>

<Field index="1" type="index" key="alias.host" />
<Field index="4" type="value" key="threat.desc" />
<Field index="2" type="value" key="threat.source" />
<Field index="3" type="value" key="threat.category" />

</Fields>

</FlatFileFeed>

</FDF>

Feed Definition Equivalents for Custom Feed Wizard Parameters

The NetWitness Feeds wizard provide options to define the structure of the data feed file. These
correspond directly to attributes in the feed definition (.xml) file.

NetWitness

Parameter

Feed Definition File Equivalent

Feed Type

Feed Task Type

Name

File/ Browse

(STIX, Recurring)
Trust All Certificate

(STIX, Recurring)

Certificate/Browse

XML Feed File

Separator

Define Feed tab

Select: Default - to define a feed based on a . csv formatted feed data file.
STIX - to define a feed based on STIX formatted . xml file.

Select: Adhoc - to create an on-demand feed. Recurring - to create a feed that
recurs automatically.

Enter a custom feed name in the feed data file that corresponds to the
flatfeedfile name attribute in the feed definition file; for example,
Dynamic DNS Test Feed,

Enter a name of the feed data file that corresponds to the flatfeedfile
path attribute in the feed definition file; for example, dynamic_dns.csv,

Select Trust All Certificate, if you do not want to validate the REST server
certificate. This option is enabled by default (checked).

For client authentication with the REST URL, in the Certificate field, click
Browse and select the self signed certificate. The supported certificate formats
are .cer, .crt with Base64 & DER encoded files.

Define Feed tab - Advanced Options
Enter a name of the feed definition file, for example, dynamic_dns.xml,

The separator character used to separate attributes in the feed data file. It
corresponds to the flatfeedfile separator in the feed definition file; for
example, a comma.
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NetWitness

Parameter

Feed Definition File Equivalent

Comment

Remove STIX data
older than

Select Services tab

(Define Columns tab,
Define Index) Type

(Define Columns tab,
Define Index) CIDR

(Define Columns tab,
Define Index)
Service Type

(Define Columns tab,
Define Index)
Truncate Domain

(Define Columns tab,
Define Index) Ignore
Case

(Define Columns tab,

The character used to identify a comment in the feed data file. It corresponds
to the flatfeedfile comment attribute in the feed definition file; for
example, #.

The number of days for which the STIX packages downloaded from TAXII
server have to be stored. The STIX packages older than the specified number
of days are deleted automatically. The default value is 180 days, which is also
the maximum.

Select the services to which you want to send the data feed.

The type of lookup value in the index position of the feed data file.

IP means that each row in the feed data file contains an IP address in the
lookup value position. The IP value is in dotted-decimal format (for example,
10.5.187.42).

IP Range means that each row in the feed data file contains a range of IP
addresses in the lookup value position. The IP range is in CIDR format (for
example, 192.168.2.0/24). Non IP means that the each row in the feed data file
contains a metadata value other than IP address in the lookup value position.
The Service Type and Truncate Domain, and Callback Keys fields become
active for a Non IP index.

Specifies that the IP value in the lookup position is in CIDR format. The
CIDR attribute sets the IP address format in the field to Classless Inter-
Domain Routing (CIDR) notation.

For a Non IP index, the integer service type to filter meta lookups. It
corresponds to MetaCallback apptype attribute in the feed definition file. A
value of 0 indicates no filtering by service type.

For a Non IP index, for meta values that contain domain names (for example,
hostnames), the system can strip off the host specific element in the data.
Truncate Domain corresponds to the MetaCallback truncdomain attribute. If
the value is www.example.com, it is truncated to example.com. A value of
False selects no truncation, and True selects truncation.

If this option checked, the feed will ignore the case.

For a Non IP index, the available meta keys to match on instead of ip.src/ip.dst

Define Index) (the defaults for IP index type) are selectable from the drop-down list.

Callback Keys The Callback Key corresponds to the MetaCallback name attribute, and
the index column of the csv file must contain data that can match the chosen
meta key. For example, if the username meta key is chosen, the index column
of the csv file needs to be populated with users to be matched.
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NetWitness

Parameter

Feed Definition File Equivalent

(Define Columns tab, Identifies the column in the feed data file that provides the lookup value for the

Define Index) row. Each position in each row of the feed data file is identified by a Field

Index Column index attribute in the feed definition file. A field with an index of 1 is the first
entry in a row, the second field has an index of 2, the third field has an index
of 3, and so on. You can select multiple index columns, if the Feed Type is
STIX and Index Type is Non IP. When you select multiple index columns the
values from all the selected columns are merged in the first index column that
you selected.

(DEFINE VALUES) The name of the LanguageKey, as defined in the feed definition file, for

Key which meta is created from this row of the feed data file. It corresponds to the
Field Kkey attribute in the feed definition file. A key applies only to a field
whose type is set to value, In the feed definition file, there is a list of
LanguageKeys from index.xml, or a summary name if Source Name and
Destination Name are used. For example, reputation is a summary name for
reputation.src and reputation.dst). This value is referenced by the Field key
attribute.
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Creating a Custom Feed

This topic provides instructions for creating a custom feed using a .csv or STIX formatted feed data file
in NetWitness. For more information about STIX and creating a STIX custom feed, see Create a STIX
Custom Feed.

You can easily create a custom feed using the Custom Feed wizard. To complete this procedure, you
need a feed data file in . csvor .xm1 format. If you also have an associated feed definition file

in .xml format, which describes the structure of the feed data file, you can use the feed definition file to
create a feed. The Custom Feed wizard can create the feed based on a feed data file, or based on a feed
data file and corresponding feed definition file.

After completing this procedure, you will have created a custom feed.

The feed data file (.csv or STIX (.xm1)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness server.

Note: Any feeds that are created in 11.2 release or prior will be automatically pushed to Context Hub
as Lists. The lists can be looked up in the context lookup panel of the Respond and Investigate pages.
If Context Hub is not configured or the service is down, then the feeds will be pushed to Context Hub
the next time the server is available.

To create a custom feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds view is displayed.

NETWITNESS Investigate Re d Users osts Yashboard Reports admin v
VE CONTENT SUBSCRIPTIONS CAPTURE POLICIES NMCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS

+ \

O Mame Trigger Disk Usage Created Last Run Time Status Progress

O TEST Once - 2019-07-1313:30:36  2019-07-1313:30:36  Completed C—

O TEST2 Once - 2019-07-1313:50:33  2019-07-13 13:50:33  Completed C—

O e Once - 2019-07-14 04:16:31  2019-07-14 04:16:51  Completed C—

O onlydom Once - 2019-07-14 04:21:37  2019-07-14 04:21:37  Completed C—

O PCAP Once - 2019-07-14 09:30:49  2019-07-14 09:30:4%9  Completed C—

2. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

(®) Custom Feed

) Identity Feed
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3. To select the feed type, click Custom Feed and Next.
The Configure a Custom Feed wizard is displayed, with the Define Feed form open.

(Configure a Custom Feed

Define Feed Select Services Define Columns Review
Feed Type @ csv O STIX
Feed Task Type @' Adhoc Recurring

Name *

Upload As Csv |
File Feed

File * Select File Browse

Advanced Options

Reset Cancel Next

4. To define a feed based on a . csv formatted feed data file, select CSV in the Feed Type field.

5. To define an on-demand feed task that executes once, select Adhoc in the Feed Task Type field and
do one of the following:

a. (Conditional) To define a feed based on a .csv formatted feed data file, type the feed Name.
b. Select the checkbox Upload As CSV File Feed, if required.

c. Select a .csv content File from the local file system, and click Next.
d. (Conditional) To define a feed based on an XML feed file, select Advanced Options.
The Advanced Options are displayed:

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Feed Type OfeY] STiX
Feed TaskType @ Adhoc Recurring
Narme *

Upload As Csv

File Feed !

File * Select File Browse

) Advanced Optio

XML Feed File | Select File Browse
Separator

Comment #

Reset Cancel Next

e. Select an XML feed file from the local file system, choose the Separator (default is comma), and
specify the Comment characters used in the feed data file (default is #), and click Next.

f. The Select Services form is displayed. This is an example of the form for a feed based on a feed
data file with no feed definition file. If you are defining a feed based on a feed definition file, the
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Define Columns tab is not needed.

Configure a Custom Feed

Define Feed Select Services Define Columns

Services
O i Name ~ Address Type
Ll g Decoder
Ll g - Decoder
Ll g Decoder
L g Log Decoder
O s Decoder
L & . Log Decoder
O s Decoder
L & Decoder
Ll g Decoder
O . Log Decoder
Ll g Log Decoder
O . Decoder
Ll g Decoder
O« A Log Decoder
Reset Cancel Prev Next

6. To define a recurring feed task that executes repeatedly at specified intervals, during a specified date
range.

a. Select Recurring in the Feed Task Type field.
The Define Feed dialog includes the fields for a recurring feed.

Configure a Custom Feed

Define Feed Select Services Define Columns Review
Feed Type @ csv O sTix
Feed TaskType O Adhoc ® Recurring
Name * TestFeed
Upload AsCsv
File Feed
URL* Verify
[ Authenticated
[ Use Proxy
Recur Every ¢ v
[ Date Range
) Advanced Options
XML Feed File | Select File Browse
Separator
Comment #
Reset Cancel Next
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b. In the URL field, enter the URL where the feed data file is located, for example,
http://<hostname>/<feeddatafile>.csv, and click Verify.

NetWitness verifies the location where the file is stored, so that NetWitness can check for the
latest file automatically before each recurrence.

c. (Optional) If the URL has restricted access and requires authentication using your username and
password, select Authenticated.

NetWitness provides your user name and password for authentication to the URL.

d. If you want the NetWitness server to access the Feed URL through a proxy, select Use Proxy.
For more information on configuring a proxy, see the Configure Proxy for NetWitness topic in
the System Configuration Guide. By default, the Use Proxy checkbox is not selected.

NOTE:
If you are using an HTTPS based feed server, ensure that you import and install the certificates.
For more information, see Import Certificates for HTTPS Service

e. To define the interval for recurrence, do one of the following:
¢ Specify the number of minutes, hours, or days between recurrences of the feed.

¢ Specify recurrence every week, and select the days of the week.

f. To define the date range for the execution of the feed to recur, specify the Start Date and time
and the End Date and time.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Feed Type ® Default STIX

Feed Task Type O Adhoc ® Recurring

Name * Testfeed

URL* https://gasa2.netwitness.local/live/feeds Verify
Authenticated

Use proxy

XML Feed File Browse
Separator

Comment

Reset Ccancel Next

7. (Conditional) If you want to define a feed based on an XML feed file:
o Type the feed Name, select Advanced Options.
The Advanced Options fields are displayed.

o Select an XML feed file from the local file system, choose the Separator (default is comma),
specify the Comment characters used in the feed data file (default is #) and click Next.
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8. To identify services on which to deploy the feed, do one of the following:

The Select Services dialog is displayed.

Configure a Custom Feed

Define Feed

Services m
[l # Name ~
O
O
O &

O &
=g
O
Og
O &

O &

O &

O &

Ds
O &

O«

Select Services

Define Columns

Decoder
Log Decoder
Decoder
Log Decoder
Decoder
Decoder
Decoder
Log Decoder
Log Decoder
Decoder
Decoder

Log Decoder

Review

a. Select one or more Decoders and Log Decoders, and click Next.

b. Click the Groups tab and select a group. Click Next.

The Define Columns dialog is displayed.

9. To map columns in the Define Columns form:

a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

b. (Conditional) If the index type is IP or IP Range and the IP address is in CIDR notation, select

CIDR.

c. (Conditional) If the index type is Non IP, additional settings are displayed. Select the service
type and Callback Keys, and optionally select the Truncate Domain and Ignore Case option.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review

Type Owp (0 IP Range ® Non IP

Index Column 1 v ServiceType 0 ¢ [¥ Truncate Domain Ignore Case

CallbackKey (S) |

K
0s

access.point
Column | [

Define Value
accesses
Key action
SRM_Sa alert

ANCEsT| alert.id Pe
| alias.host |
" alias.ip
< alias.ipvé
alias.mac
asn.dst

asn.src

srao Lo .

Reset Cancel Prev Next

d. Select the language key to apply to the data in each column from the drop-down list. The meta

displayed in the drop-down list is based on the meta available for the service define values. You
can also add other meta based on advanced expertise.

Configure a Custom Feed

Define Feed Select Services Define Columns Review
vetin ge
Type Ow O IP Range @® Non IP
Index Column 1 v Service Type 0 ¢ [¥ Truncate Domain Ignore Case
Callback Key (S) action @ v
vetine ues
Column 2 3 4
Key threat.source v threat.category v threat.desc
SRM_SaaS_ES MXASSETInterface AddChange EN
ANCESTOR ASSETNUM ASSETTAG ASSETTYPE
cent45 9164
cent45 9164
Reset Cancel Prev Next
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Note: When a custom feed gets converted into a context hub list, you must map at least one
meta key with one or more meta types by mapping a column header with a meta. However, you
can add or edit the entity mapping of a list by clicking % in the Lists tab. For more
information, see the Context Hub Configuration Guide.

e. Click Next.
The Review dialog is displayed.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Testing

AssetsimportCompleteSample.csv

Log Decoder, Decoder

Other
action
true

0

1 2 3 4

Index threatsource threat.category threat.desc

Reset Cancel Prev Finish

10. Anytime before you click Finish, you can:
¢ Click Cancel to close the wizard without saving your feed definition.
¢ Click Reset to clear the data in the wizard.
¢ Click Next to display the next form (if not viewing the last form).
¢ Click Prev to display the previous form (if not viewing the first form)
11. Review the feed information, and if correct, click Finish.

12. Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were
successful.

Note: When you create a feed, and if there is no entity mapping done such as in case of custom meta,
then those columns in the List will not have entity mappings in Context Hub. You have to manually
map the entities from the List page.

Import Certificates for HTTPS Service

Import certificates to communicate with the HTTPS services:
1. SSH to the NW node and copy the CA certificate located in the following directory:
Jetc/pki/ca-trust/source/

2. Execute the following command to update the certificates:
update-ca-trust
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3. Execute the following command to add the certificate to the java keystore:
keytool -list -keystore /etc/pki/java/cacerts -storepass changeit

4. Restart the service on the NW node.

| & head

Note: Perform the procedure for all the HTTPS servers.
Example: HTTPS proxy server and HTTPS feed server.
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Create a STIX Custom Feed

You can create a custom feed using a .csv or STIX formatted feed data file in NetWitness.

Note: NetWitness supports Structured Threat Information Expression (STIX) 1.0, 1.1 and 1.2 versions
only.

Structured Threat Information Expression (STIX™) is a structured language for describing cyber threat
information so it can be shared, stored, and analyzed in a consistent manner. For more information about
STIX, see https://oasis-open.github.io/cti-documentation/.

Caution: If STIX recurring feed is configured and you update Security Analytics from 10.6.x to
NetWitness 11.0, you must re-configure the STIX recurring feed.

In NetWitness Platform XDR, STIX feeds are supported. STIX content (with version 11.x) can be
uploaded in an ".xml" format. The constructs such as Indicator Title and Description, Observable Title
and Description, and Indicator Sightings information are parsed from STIX and pushed to the decoders
or log decoders that are selected during feed configuration. Information such as IP addresses, File hashes,
Domain names, URIs, and Email addresses are extracted from the STIX observable to be included in the
feed.

Make sure the following criteria are met before you upload the STIX file:
1. Only STIX Observables with property values in the "Equals" operator
2. The uploaded STIX xml file must have only one STIX Package

TAXII (Trusted Automated eXchange of Indicator Information) is the main transport mechanism for
cyber threat information represented in STIX. Using the TAXII services, organizations can share cyber
threat information in a secure and automated manner.

The STIX and TAXII communities work closely together to ensure that they continue to provide a full
stack for sharing threat intelligence.

Apart from TAXII server, STIX data can also reside on REST server and you can fetch STIX file from
the REST server by providing the URL of the REST server. For example,
http://stixrestserver.internal.com.

The feed data file (. csv or STIX (. xm1)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness server.

In NetWitness Platform XDR, STIX (.xml) feed of type Indicators or Observable which contains the
properties such as the IP addresses, File hashes, Domain names, URIs and Email addresses are
supported. The properties values in the Equals operator is only supported. The STIX constructs that are
parsed are Indicator Title and Description, Observable Title and description and Indicator Sightings
information. The STIX (.xml ) with a single STIX Package is only supported."

To create a STIX custom feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds view is displayed.

2. In the toolbar, click +
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The Setup Feed dialog is displayed.

Setup Feed

® Custom Feed

) Identity Feed

Cancel

3. To select the feed type, click Custom Feed and Next.
The Configure a Custom Feed wizard is displayed, with the Define Feed dialog open.

Configure a Custom Feed

Define Feed Select Services Define Columns Review.

[ Date Range
Advanced Options

XML Feed File | Select File Browse

4. Enter the following details:
a. Feed Type: Select STIX, to define a feed based on a STIX formatted . xm1 file.

=

Name: type the feed name, to define a feed based on STIX formatted . xm1 file.
c. STIX Source:Select a STIX data source from the drop-down which is added in Context Hub.

d. Recur Every: Specify a recurring feed task that executes repeatedly at specified intervals.

Note: NetWitness verifies the connection to the server, so that NetWitness can check for the latest
file automatically before each recurrence.

e. Date Range: Select the checkbox and specify the date range for the feed task to recur.
5. (Optional) Select Advanced Options,to define a feed based on an XML feed file.

a. XML Feed file: Browse and select an XML feed file from the local file system.
b. Separator: Choose a separator (default is comma).

c. Comment: Specify the comment characters used in the feed data file (default is #).

6. Click Next.
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7. The Select Services dialog is displayed. This is an example of the form for a feed based on a feed
data file with no feed definition file. If you are defining a feed based on a feed definition file, the
Define Columns tab is not needed.

[Configure a Custom Feed

Define Feed Select Services Define Columns Review

Services Group:
¥ & Nam Add Type

¥ & Log Decoder
¥ Decoder

8. To identify services on which to deploy the feed, do one of the following:

a. Select one or more Decoders and Log Decoders, and click Next.

b. In case of STIX feed, Context Hub will be selected by default and you are not allowed to deselect
it. In addition, you can select one or more Decoders and Log Decoders and click Next or Click
the Groups tab and select a group. Click Next.

If the data from the STIX server is large, the following message is displayed:

Fetching sample data is taking longer than expected.
Choose one of the following options

Continue to Wait Map without Sample data

* If you click Continue to Wait, it continues to wait till the sample data is fetched or timeout
(10 minutes) whichever is sooner. In case of timeout no sample data is retrieved even after 10
minutes.

* If you click Map Without Sample data, the mapping column is displayed without any sample
data.

The Define Columns dialog is displayed.
9. To map columns in the Define Columns form:
a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

b. (Optional) If the index type is IP or IP Range and the IP address is in CIDR notation, select
CIDR.

c. (Optional) If the index type is Non IP, additional settings are displayed. Select the service type
and Callback Keys, and optionally select the Truncate Domain option.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review

Type @ 1p Non IP

Index Column(s) |10 v Llcior

Column 1 2 8 4
Key v v v v

Header Indicator Title Indicator Description Observable Title Observable Description

Some Indicator <p>Some Indicator</p> domain:domaini.exa... domain:domain1.exa...
Some Indicator <p>Some Indicator</p> domain:domain2.exa...  domain:domain2.exa...
indicator-domain auto domain test domain test domain desc

Another Indicator <p>Another Indicator...  domain:domain3.exa...  domain:domain3.exa...

Reset Cancel Prev Next

Note:

- If the Index Type is Non IP, you can select multiple index columns in the Index Column(S).
The values from all the selected columns are merged in the first index column that you selected
and the merged values are pushed to the Log Decoder for parsing. For example, in the Index
Column(S) if you select 2,4,7 as index columns the values from the 2,4 and 7 columns are
merged in the column 2 and the values are pushed to Log Decoder for parsing.

- Indexing cannot be done for the columns such as Indicator Title, Indicator Description,
Observable Title, Observable Description, as the look up cannot be performed for those
columns.

d. Select the language key to apply to the data in each column from the drop-down list. The meta
displayed in the drop-down list is based on the meta available for the service define values. You
can also add other meta based on advanced expertise.

e. Click Next.
The Review dialog is displayed.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review

FILESTIX
FILESTIX-stix.xml

PH - Decoder, LH - Log Decoder

false

10 24

Index event.desc

Reset Cancel Prev Finish

10. Anytime before you click Finish, you can:

¢ Click Cancel to close the wizard without saving your feed definition.

¢ Click Reset to clear the data in the wizard.

¢ Click Next to display the next dialog (if not viewing the last form).

¢ Click Prev to display the previous dialog (if not viewing the first form)

11. Review the feed information, and if correct, click Finish.

12. Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were

NETWITNESS ves e Respond S osts Files Dashboard Reports admin v
LIVE CONTENT  SUBSCRIPTIONS CAPTURE POLICIES ICIDENT RULES INCIDENT NOTIFICATIONS
Feeds
+
Name Trigger Feed Size Created Last Run Time Status Progress
FILEHASH Fetches STIX feeds from 2020-May-19 03:16, running every 5 minutes 0 bytes 2020-05-19 03:25:23 2020-05-22 05:16:01 Completed CE——
FILESTIX Fetches STIX feeds from 2020-May-18 03:32, running every 5 minutes 0 bytes 2020-05-19 03:32:09 2020-05-22 05:12:09 Completed e
AllindicatorsREST Fetches STIX feeds from 2020-May-19 04:48, running every 5 minutes 0 bytes 2020-05-19 05:03:52 2020-05-22 05:13:26 Completed e
ALLIndEdited Fetches STIX feeds from 2020-May-19 05:13, running every 5 minutes 0 bytes 2020-05-18 05:13:54 2020-05-22 05:13:54 Completed eemmm———
TAXlIServer1 Fetches STIX feeds from 2020-May-19 05:44, running every 5 minutes 288 bytes 2020-05-19 05:44:38 2020-05-22 05:14:38 Completed C——

Note: Health and Wellness raises alerts when the available heap memory of Context Hub server is
critically low and the status displays as unhealthy due to low memory. For more information on how to
troubleshoot the OutOfMemoryError on the Context Hub Server, see "Troubleshooting" in the Live
Services Management Guide.
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MetaCallback Feeds using CIDR Index Range for IPv4 and IPv6

You can use CIDR index ranges for IPv4 and IPv6 in custom MetaCallback feeds. As with other custom
feeds, you must create feed data file in .csv format, and a feed definition file in .xml format.

Note: Using MetaCallback feeds with CIDR index ranges is supported only through the Advanced
Configuration wizard or the REST interface.

The following example shows the content of both a .csv file and an .xml file for a MetaCallback feed
using CIDR index ranges for IPv4 or IPv6.

CSV File Content

192.168.0.0/24, Sydney
192.168.1.0/24, Melbourne

XML File Content

<?xml version="1.0" encoding="UTF-8"?><FDF
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="feed-definitions.xsd">

<FlatFileFeed name="ip_test" path="ip_test.csv" separator="," comment="#">
<MetaCallback name="DstIP" valuetype="IPv4" apptype="0" truncdomain="false">
<Meta name="ip.dst"/>

</MetaCallback>

<LanguageKeys>

<LanguageKey name="alert" valuetype="Text" />

</LanguageKeys>

<Fields>

<Field index="1" type="index" range="cidr"/>

<Field index="2" type="value" key="alert" />

</Fields>

</FlatFileFeed>

</FDF>

Note: To configure a CIDR index range for feeds with single or multiple MetaCallbacks of value type
[Pv4 or IPv6, the field of type index MUST contain a range attribute with range="cidr". Also,
configuring "cidr" index ranges for feeds with MetaCallbacks of multiple different value types is not
supported.
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Creating and Managing an Identity Feed

You can easily create an Identity feed and populate it to selected Decoders and Log Decoders. After
completing this procedure, you will have created an Identity feed.

To create an identity feed:

1. Add a destination for the feed.
Q
a. Goto (Admin) > Services and in the Services.

b. In the list of services, select a Log Collector service, and select ﬁ' ~ View > Config.

Select the Event Destinations tab.

d. In the Select Event Destinations field, select Identity Feed.

-+ Change Service . : Config

General Remote Collectors Files AUt i3 Event Destinations Settings

SEIEE: R ‘ Identity Feed w
Destinations

| Log Decoder
Identity Feed  identity Feed

+
e. Click and enter a unique name for the feed.
The Queue name identifies the feed within the Log Collector. Use the name of the feed for the
Queue.
Add Identity Feed
Name * infonetd_domain
Queue |inf0netd_domain| |
Rollover Interval 3
Update Interval 1

Event Source Filter

Start Processor On It
Service Startup

Cancel OK

f. Click OK.

2. Test generation of messages.

a. Have users log into Windows boxes on the domain to generate the appropriate log messages on
the domain controllers for testing.
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b. Verify that data is written to the feed files. SSH to the Log Decoder/Collector or Virtual Log
Collector being configured. Navigate to
/var/netwitness/logcollector/runtime/identity-feed and verify that the
Identity deploy files are getting populated with data.

[root@tps-reports identity-feed]# pwd
/var/netwitness/logcollector/runtime/identity-feed
[root@tps-reports identity-feed]# 1s -lah

total 20K

drwxr-xr-x. root root 109 Nov & 18:06 .

2
drwxr-xr-x. 8 root root 4 0K Nov 12 23:14
1

=MWN=F==r==, root root 106 Nov 13 15:24 identity.deploy.csv

. 1 root root| 408 Npv 13 15:24 identity_deploy.feed
-Mw=-r--r--, 1 root root _S9al Nov B 09:00 identity_deploy.xml
-rw-r--r--. 1 root root | 158 llov 13 15:17 identitycache.csv
[root@tps-reports identity-feed]# |

c. Open up a web browser (Non-Internet Explorer browsers preferred) and log in to the REST
interface of the Log Collector. Use administrative credentials when logging in. For example, if
the IP address of your Log Collector is 192.168.99.66, the URL would be:

e SSL not enabled: http://192.168.99.66:50101/event-processors
e SSL enabled: https://192.168.99.66:50101/event-processors

The browser screen should look like this:

|80 0o Response "3
lal> | |2] [+ O 192.168.99.66:5010 < | O]
[I] &5 RSA ™ Wikiand eRoom ¥ RSALink~™ SA~Y Personal ¥ r':

™)

]

The screen contains the name of the identity feed you created earlier (infonetd domain, in this
example).

For the identity feed to function correctly, port 50101 must be active on the Log Collector, and
you must determine whether SSL encryption is active.
2 :
d. Goto (Admin) > Services > <Log Collector being setup> ?‘} > View > Explore.

e. In the left pane, expand rest > config.
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& Change Service | endpointloghybrid - Log Collector | Explore &

~— PR o . frest/config

Z endpointloghybrid - L...

allow.missing.user.agent
H kgl endpointloghybrid - Log Collector (LOG_C...
allow.websockets

B[ Jcornections
enabled
B[ deviczappliance
port
B[ Jeventbroker _
5
EVent-processors e
Devencp user.agent.whitelist
B[ Jlegeollection
B[ Jlegs
B rest
I:Iccmﬁg
[Jstats
[ sdk

endpointloghybrid - Log Collector

For REST to be active, enabled must be set to 1.

f. Note the value for ssl. If SSL should be enabled for your environment, this must be set to on.

Collector service before moving forward.

Note: If you changed the setting for either the enabled or ssl option you must restart the Log

3. Goto (Configure) > Custom Feeds.
The Feeds dialog is displayed.

NETWITNESS vestigate d S Hosts Files

VE CONTENT SUBSCRIPTIONS CAPTURE POLICIES NCIDENT RULES

Trigger Disk Usage Created
Once
Once
Once

Once

Once

Dashboard

Reports

INCIDENT NOTIFICATIONS

Last Run Time

Status

Completed
Completed
Completed
Completed

Completed

admin v

CUSTOM FEEDS

Progress
——
——

C—

4. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

Custom Feed

(@) |dentity Feed

Cancel

5. Make sure Identity Feed is selected and click Next.
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The Configure Identity Feed panel opens with the Define Feed tab displayed.

6. (Conditional) You can create an on-demand or recurring feed.

¢ To define an on-demand Identity feed task that executes once, select Adhoc in the Feed Task
Type field, type the feed Name, and browse for and open the feed.

o To define a recurring Identity Feed task that executes on a recurring basis, select Recurring in the

Feed Task Type field.

The Define Feed dialog includes the fields for a recurring feed.

Configure Identity Feed

Select Services Review

Define Feed

Feed Task Type Adhoc @® Recurring

Name *

[ Authenticated  User Name admin Password esessssses

[ Use proxy
Recur Every 5 & Minute(s)

Date Range

Start Date 2015-12-1419:10:25 (i End Date  2025-12-1413:11:27

Reset Cancel

URL * >r name]?msg=getfile&force-content-type=application/octet-stream&expiry=600 || Verify

Note: NetWitness verifies the location where the file is stored, so that NetWitness can check for
the latest file automatically before each recurrence.

7. Enter a value and verify the URL field.

a. In the URL field, enter the URL where the feed data file is located. This is the REST API
interface that was setup earlier. Make sure you have the following information to construct the

URL:

e The IP address of the Log Collector being used to construct the Identity Feed file.

¢ The identity queue name, as set in step 2c.

e Whether or not SSL is enabled on the Log Collector REST port, as set in step 2f.

You can construct this value as follows:

e SSL enabled: https://<LogCollector>:50101/event-processors/<ID Event
processor name>?mnsg=getFile&force-content-type=application/octet-

stream&expiry=600

e SSL not enabled: http://<LogCollector>:50101/event-processors/<ID Event
processor name>?msg=getFile&force-content-type=application/octet-

stream&expiry=600

So, using the example from earlier, the complete value that you would enter into this field is as

follows:

http://192.168.99.66:50101/event-processors/infonetd
domain?msg=getFile&force-content-type=application/octet-
stream&expiry=600?msg=getFile&force-content-type=application/octet-

stream&expiry=600
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b. For the URL verification to work correctly, it is important that the NetWitness Ul server can
access the Log Collector’s REST API port (50101). This can be tested by going to the
NetWitness Ul server via SSH. Once there, run the following command:

e SSL enabled: curl -vk https://<ip of log collector>:50101

¢ SSL not enabled: curl -v http://<ip of log collector>:50101

If the curl command does not connect then there may be a network firewall or routing issue
between the NetWitness Ul server and the Log Collector.

Example of a bad connection:

* About to connect () to 192.168.99.66 port 50105 (#0)
* Trying 192.168.99.66... No route to host

* couldn't connect to host

* Closing connection #0

curl: (7) couldn't connect to host

Example of a good connection:

About to connect() to 192.168.99.66 port 50105 (#0)

Trying 192.168.99.66... connected

Connected to 192.168.99.66 (192.168.99.66) port 50105 (#0)

GET / HTTP/1.1

User-Agent: curl/7.19.7 (x86 64-redhat-linux-gnu) libcurl/7.19.7
SS/3.19.1 Basic ECC zlib/1.2.3 1libidn/1.18 libssh2/1.4.2

Host: 192.168.99.66:50105

Accept: */*

*
*
*
>
>
N
>
>
>
< HTTP/1.1 401 Unauthorized

< Content-Length: 71

< Connection: Keep-Alive

< Pragma: no-cache

< Expires: -1

< Cache-Control: no-cache, no-store, must-revalidate
< WWW-Authenticate: Basic realm="NetWitness"

< Content-Type: text/xml; charset=utf-8

<

<?xml version="1.0" encoding="utf-8"?>

<error>401 Unauthorized</error>

* Connection #0 to host 192.168.99.66 left intact
* Closing connection #0

8. The REST API requires a username and password when attempting to pull the identity

deploy.csv file from the Log Collector. This can be any username and password that is available
on the service itself. For more information, see the "Services Security View" topic in the Hosts and

Services Guide.

Q
To see which accounts are available, go to (Admin) > Services > <log collector being setup>

> Actions > View > Security.

Under the Users table, you see all the users that can be used in this step. It is suggested that a
separate user account is created specifically for this setup, and is used nowhere else in the
environment, for added security. For details, see "Add a User and Assign a Role" in the System

Security and User Management Guide. (Go to the NetWitness All Versions Documents page and find

NetWitness Platform guides to troubleshoot issues.)

9. To define the recurrence interval, do one of the following:
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10.

1.

12.

13.

14.

¢ Specify the number of minutes, hours, or days between recurrences of the feed.
¢ Enter the date range for the execution of the feed to recur, specify the Start Date and time and the
End Date and time.

If using SSL encryption, you need to install the REST API SSL certificate for the Log Collector into
the NetWitness Ul server. For more information, see Import the SSL Certificate.

If, after importing the SSL certificate, the verification of the URL still fails, see Cannot Verify
Identity Feed URL.

Click Verify to verify your identity feed configuration before you proceed to the Select Services
dialog.

Click Next.

The Select Services dialog is displayed.

Configure Identity Feed

Define Feed Celect Services Review
L ﬁ( Name ~ Address Type
O o ' Decoder Decoder
] 55( Log Decoder Log Decoder
Reset Cancel Prev Mext

To identify services on which to deploy the feed, select one or more Decoders and Log Decoders
and click Next.

Click the Groups tab, select a group, and click Next.
The Review dialog is displayed.
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Configure Identity Feed

Define Feed Select Services
ed Details
Mame Testing
Feed File zip sample.zip
service Uetails
Services Decoder

Cancel

Note: If a group of devices with Decoders and Log Decoders is used to create recurring or custom
feeds and this group is deleted, you can edit the feed and add a new group to the feed.

15. Anytime before you click Finish, you can:
¢ Click Cancel to close the wizard without saving your feed definition.
¢ Click Reset to clear the data in the wizard.
¢ Click Next to display the next form (if not viewing the last form).
¢ Click Prev to display the previous form (if not viewing the first form).
16. Review the feed information, and if correct, click Finish.

Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can expand
or collapse the entry to see how many services are included, and which services were successful.

NETWITNESS v nd sers osts Jashboard  Reports

admin v

LIVE CONTENT SUBSCRIPTIONS INCIDENT RULES C NO CATIONS RULES ARSER RULES

Feeds

+

O Name Trigger Feed Size Created Last Run Time Status Progress
B FILEHASH Fetches STIX feeds from 2020-May-19 03:16, running every 5 minutes 0 bytes 2020-05-15 03:25:23 2020-05-22 05:16:01 Completed CEE—
B FILESTIX Fetches STIX feeds from 2020-May-19 03:32, running every 5 minutes 0 bytes 2020-05-15 03:32:08 2020-05-22 05:12:09 Completed ]
B AllindicatorsREST Fetches STIX feeds from 2020-May-19 04:48, running every 5 minutes 0 bytes 2020-05-13 05:03:52 2020-05-22 051326 Completed =
B AlLindEdited Fetches STIX feeds from 2020-May-19 05:13, running every 5 minutes Q bytes 2020-05-19 0511354 2020-05-22 051354 Completed C——
B TAXIIServer1 Fetches STIX feeds from 2020-May-19 05:44, running every 5 minutes 288 bytes 2020-05-19 05:44:38 2020-05-22 05:14:38 Completed aEmmm———

60 Deploy Content



Live Services Management Guide

Import the SSL Certificate

If SSL is configured on the Identity feed’s Log Collector, follow these steps to import the Log
Collector’s SSL certificate into the NetWitness Ul server key store. If this certificate is not imported, the
NetWitness Ul server will be unable to pull the Identify feed file from the Log Collector.

L.

To pull the SSL certificate off the Log Collector, SSH into the NetWitness Ul server and run the
following command:

echo -n | openssl s client -connect <HOST>:<PORT> | sed -ne '/-BEGIN
CERTIFICATE-/,/-END CERTIFICATE-/p' > /tmp/<SERVERNAME>.cert

This command saves the SSL certificate to / tmp/<SERVERNAME>. cert. For example:

echo -n | openssl s client -connect 192.168.99.66:50101 | sed -ne '/-BEGIN
CERTIFICATE-/,/-END CERTIFICATE-/p' > /tmp/logcollector.cert

To import the SSL certificate into the NetWitness Ul server, SSH into the Ul server and run the
following command:

keytool -importcert -alias <name an alias for the cert> -file <the cert
file pathname> -keystore /etc/pki/java/cacerts

For example:

keytool -importcert -alias logcollector0l -file /tmp/logcollector.cert -
keystore /etc/pki/java/cacerts

The system requests a password. Enter the password for the keystore on the NetWitness Ul server,
not for the jetty keystore. The default password is changeit.

4. Restart jettysrv to allow jetty to read the new certificate in the store.

Cannot Verify Identity Feed URL

If the Identity feed URL cannot be verified, and you are using SSL, make sure you followed the steps in
Import the SSL Certificate.

If there are issues, it is possible that the internal name of the certificate does not match the hostname of
the Log Collector. The following procedure checks this.

1.

SSH to the NetWitness Ul server.

2. Run the following command to output the CN name of the SSL cert:

echo -n | openssl s client -connect <log decoder>:50101 sed -ne '/BEGIN

CERTIFICATE-/, /—END_CERTIFICATE—/p'

For example:

echo -n | openssl s client -connect salogdecoder01:50101 | sed -ne '/BEGIN
CERTIFICATE-/,/-END CERTIFICATE-/p'

3. Retrieve the CN name of the SSL certificate.
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4. Edit the /etc/hosts file and add the IP address and CN name to the file.

5. Restart the network service on the appliance.

6. Confirm that the name placed in the /etc/hosts file is used instead of the FQDN or IP address in the
Identity feed URL.

7. Re-verify the Identity feed URL.

Investigating an Identity Feed

An identity feed tracks interactive log on events from the Windows operating system. Identity feeds do
not track interactive log off events.

In order for an identity feed to process events and tag them, the events need to be collected using
a Windows Log Collection module where an Active Domain Controller or non-Domain Controller is
configured. Note that identity feeds can only be processed via an Identity Feed Event Processor.

Note: An identity feed only tracks one log in at a time. If two users log in to a system at the same
time, the second user will overwrite the first user's data in the identity feed.

Once you have created an identity feed, you can view the results by investigating the feed.

To investigate a configured identity feed:
1. Go to INVESTIGATE > Navigate.

If no default service is selected, the Investigate dialog is displayed.

Investigate

Services Collections

M Default Service

MName ~ Address Type

Eroker 10.31.125.243 Eroker
Broker 10.31.125.245 Broker
Broker 10.31.125.240 Broker
Cancentrater (Default) 10.31.125.244 Cancentratcr
Decoder 10.31.125.243 Decoder

Log Decoder 10.31.125.246 Log Decoder

Cancel Navigate
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2. Select a service, usually a Concentrator, and click Navigate.

3. Select Load Values to retrieve meta data.
In the Values panel, scroll down to find the Meta Keys:
NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin w

NAVIGATE  EVENTS MALWARE ANALYSIS

& endpointloghybrid - Concentrator ¥ Query @ [ Profile @ E]Meta @ | B Total @ (= Descending @ B§ EventCount @ | Save Events

2017 93 14:50:59 (+00:00)

2012 3 15:35:00 (+00:00) All Data

dnyooT xauoes

£# Options | /™ Hide

_ Decoder Source (2 v
nwappliance23912 (>100. 5%) - nwappliance11639 (182)

13 values) £
@ - Alerts (13
test dom (=100, 5%) - gw match (=100
test (3,095) - ipv4 potential web sweep 10(2,2

- ipv4 bulk data transfer S0 mb (17)

38%) - ipv4 horizontal port scan 5 (6,458) - tele test (5,773) - address : 161.253.11.233 (4,948) - ip alert for 29.1 (3,581) - sky
)) - ipv4 vertical tcp port scan 5 (2,204) - ipv4 vertical udp port scan 5(210) - ipv4 bulk data transfer 20 mb (76) - ipsrc test 176 (37)

_ Risk: Informational (20 of 20+ values) L
'y
http1.1 without referer header (67,.513) - unknown service over http port (51.581) - unknown service over smtp port (43,798) - http1.1 without server header (39,937) - http1.0
unsupported cache header (34,360) - http1.0 unsupported connection header (32.546) - http1.0 unsupported host header (21,538) - http1.1 server location redirect (21,090) - only
ack flag in session (18,655) - unknown service over ssl port (15,679) - http1.0 without server header (12,163) - http over non-standard port (11,872) - http1.1 without accept

_httn1 N uncunnarted etag headar (£ QA7) _ httn1 1 withaut cannartinn

header(11 129 _httn1 1 hicgh headar conunt (10 @A _ hittn1 Owithoot referar headaer (7 0823

The identity feed provides information to selected Decoders and Log Decoders. It associates the Host IP
data from the Windows operating system to the user logging into that Host in order to tag all logs
associated with that IP and investigate.
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Editing a Feed

This topic provides instructions for editing a custom feed using the Custom Feed Wizard.

After you edit a feed:

e The feed (.zip format) or the file used to create the feed (.csv or .xml) has been downloaded and
edited.

e The feed has been recreated with the updated file and new feed specifications.

To edit an existing feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds dialog is displayed.

NETWITNESS d 5 Hosts Files Dashboard Reports admin v
ONTENT SUBSCRIPTIONS CAPTURE POLICIES NCIDENT RULES INCIDENT NOTIFICATIONS SA RULES CUSTOM FEEDS
+ \
O Mame Trigger Disk Usage Created Last Run Time Status Progress
O TEST Once Completad e
O TEST2 Once Completad e
O te Once Completad e
O onlydom Once Completad e
O PCAP Once Completad e

4

2. In the toolbar, select a feed and click =,

The Configure Custom Feed or Configure Identity Feed panel opens in the Custom Feed wizard.

Configure a Custom Feed

Define Feed Select Services Define Columns

Feed Type C5v = STIX
Feed Task Type @ Adhoc _} Recurring
W ame * TEST

Upload As Csv

File Feed
File * TEST-stix.xm Browse
download file
wdvanced Options
Reset Cancel MNext
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3. If you want to edit the feed file:
a. Click download file.

For an Identity feed, the .zip file is downloaded. For a custom feed, the .csv or .xml file is
downloaded to your local file system.

b. Edit and save the file.
c. In the Define Feed tab, browse for and open the edited file.

4. Edit any other parameters in the Define Feed tab, Select Services tab, and Define Columns tab that
apply to the type of feed.

5. Anytime before you click Finish, you can:

¢ Click Cancel to close the wizard without saving your changes.

¢ Click Reset to clear the data in the wizard.

¢ Click Next to display the next form (if not viewing the last form).

¢ Click Prev to display the previous dialog (if not viewing the first form).
6. In the Review tab, review the feed information, and if correct, click Finish.

The feed is added to the feeds list and progress bar tracks completion. Upon successful creation of the
feed definition file, the Create Feed wizard closes, and the feed and corresponding token file is listed in
the Feeds list. You can expand or collapse the entry to see how many services are included, and which
services are successful.
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Removing a Feed

This topic provides instructions for removing a feed. You might want to remove a feed when some or all
of the information in the feed is no longer useful for your organization.

To remove a feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds dialog is displayed.

NETWITNESS Investigate Respond Users Hosts Dashboard Reports

admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES NMCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS
Feeds

+ \
O | Name Trigger Disk Usage Created Last Run Time Status Progress

BB e g

O TEST Once - 2019-07-1313:30:36  2019-07-13 13:30:36  Completed C—

O TEST2 Once - 2019-07-1313:50:33  2019-07-13 13:50:332  Completed C—

O e Once - 2019-07-14 04:16:51  2019-07-14 04:16:51  Completed C—

O onlydom Once - 2019-07-14 04:21:37  2019-07-14 04:21:37  Completed C—

O PCAP Once - 2019-07-14 02:30:49  2019-07-14 09:30:49  Completed C—

2. In the toolbar, select a feed and click ~— .

The Delete Custom Feeds dialog is displayed.
Delete Custom Feeds

Local DB and Service

® Local DB Only

Service Only

Cancel Delete

You can select one of the following options to delete the feed:

¢ If you choose to delete the feed from Local DB and Service, the feed is deleted from both
the service and the local NetWitness box. The deleted feed will no longer seen on
the NetWitness user interface.

¢ If you choose to delete the feed from Local DB Only, the feed is deleted from the local
NetWitness box. The deleted feed will not be seen on the NetWitness user interface; however, the
last deployed version of the feeds will be present on the service. The undeployed feeds will be
deleted forever.

o If you choose to delete the feed from Service Only, the feed is deleted from the service. The
deleted feed will appear on the NetWitness user interface and can be deployed again
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3. Select which feed you want to delete and click Delete.
A warning dialog is displayed.

4. Click yes to confirm that you want to delete the feed from the selected areas.

Delete Custom Feeds

Service Status Progress

Decoder FAILURE
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Subscribing to Live Resources

This section describes subscriptions in Live.

Threats and the corporate landscape change over time. NetWitness periodically reviews existing content
to determine whether it needs to be updated based upon current campaigns, or has become irrelevant due
to changes in technology or attack techniques and tools.

You can discover new content by using the What’s New dashlet within the Default Dashboard, or by
searching through NetWitness Live by data range since last deployed. Be sure to subscribe to any content
for which you want to receive update notifications.

Subscription Updates

When you view resources in the Matching Resources panel of the Live Content view, there is a column
named Updated:

Matching Resources

= Show Resuls | | % Package
Subscribed | Name Created Updated Type Description
no Advanced Windows Execut..  2012-02-09 4:50 PM 2014-03-20 3:53 PM FlexParser Legacy: Intenc
no Fingerprint Windows M5l 2012-02-09 451 FM 2012-02-09 451 FM FlexParser Legacy: Intenc
no Microsoft Windows 2018-03-27 146 PM 2018-03-27 147 PM Log Device Log device cor
yes windows_executable 2013-10-18 1:53 PM 2007-11-13 22535 PM Lua Farser dentifies winc
no Windows Command Shell 2012-02-09 451 FM 2013-08-27 708 AM FlexParser Legacy: Intenc
yes Lateral Movernent Indicato...  2018-03-09 12:54 AM 2018-07-31 759 PM Met\Witness Report Report display
yes windows_command_shell_|.. 2013-10-18 1:55 PM 2016-11-14 6:40 FM Lua Parser dentifies Micr
yes Windows Credential Harves...  2016-03-09 12:54 AM 2016-03-09 12:54 AM NerwWitness Rule This rule moni
L] Windows Process Parent C...  2018-03-11 734 P 2018-053-11 7:34 PM MetWitness Rule There are sets
yes Windows NTLM Network Lo...  2016-03-08 12:54 AM 2015-03-059 12:54 AM NetWitness Rule ndicares a po
no Autoruns and 5cheduled Ta...  2018-05-11 7:33 PM 2018-05-11 7-33 FM NerwWitness Rule Attackers will
no Windows Events (ER) 2014-02-14 3:34 AM 201 8-03-27 8:30 AM Log Device Log device cor
no Windows Events (NIC) 2014-02-14 3:55 AM 2018-09-03 1211 PM Lag Device Log device cor

_ L4
66 Matching Resources

This value is also displayed when you select the detailed view for a resource. Every time a resource
changes, its Updated value changes to match the specific update. If you are subscribed to a resource, and
it gets updated, your system is automatically updated with the latest version, and you receive a

notification. You can view your notifications by clicking the Notification icon, ==, from anywhere in
the NetWitness UL
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LIVE CONTENT

rch Criterla

Authentication
Authorization

Accounting

Resource Types

NETWITNESS

SUBSCRIPTIONS

Inve

Respond Users

igate

INCIDENT RULES

CAPTURE POLICIES

Matching Resources

Muitiple Failed Logins ta Si
WM Clone After Multiple Ro.

Multiple Service Connectio.

23 AM

Malicious Account Creation...

NTLMSSP_lua

2013-09-16 3:06 AM

94 Matching Resources

Hosts Files

Dashboard

INCIDENT NOTIFICATIONS

2018

2018

2018

Reports

Notifications

Service Added

service has been added 1o Test 1 hour

Keywords B Show Results | | 3 Package Entitlement Expiration
subscribed . Name Created Updated or LogDecod 11 hours
Categary LDAP 2017-11-21
I reaTurED o Ker! 201205 1l
» CITHREAT yes NWFL_accountlogon-succe... 2015 M
4 5 DENTITY Multiple Login Failures Due... 2018 M View All

10.4 or higher_ Alert if there

Detects 4 failed login attemp

¥ [ ASSURANCE Remote Data Harvesting 2016 Detects & successful Juniper
¥ [ GPERATIONS yes W] gon-failure 20714-08-1 Application Rule NWFL App Rule to support I
[ sPecTRUM yes NWFL_accountlogin-and-lo... 2 2014-08-1 Application Rule NWFL App Rule to support It
[T MALWARE ANALYSIS yes untlogon-success  2012-04-20 5:00 PM 2014-08-1 Application Rule NWFL App Rule to supgort I
yes 2 0511 FM 2014-08-1 Application Rule NWFL App Rule to support It

You can also get email notifications when subscribed resources are updated. System Administrators can

Q
add email addresses in the (Admin) > SYSTEM > Live Services view. For more information, see
the "Live Services Configuration Panel" topic in the System Configuration Guide.

Adding Subscribed Resources for Deployment to Services

1. Goto (Configure) > Subscriptions > Deployments.

2. In the Groups panel, select a group.
Subscribed resources, if any, are listed in the Deployments tab Subscriptions panel.

3. In the Subscriptions panel, click +
The Add Subscription dialog, which lists subscriptions available for deployment, is displayed.

4. Select the subscribed resources that you want to deploy to the services group.
Click Save.

The dialog closes and the subscriptions are added to the listing in the Deployments tab, Subscriptions
panel. This stages the resources for deployment at the next synchronization.

6. You can click the Synchronize icon, B. , to immediately synchronize your changes.

Deleting a Subscription

When you delete a subscription to a resource, deployed instances of the resource are not deleted. The
deployed resource remains on services until explicitly removed, but the resource is no longer
synchronized with the resource in NetWitness Live.
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To delete a subscription:

1.
2.

Go to (Configure) > Subscriptions.

In the Subscriptions tab, select the subscriptions you want to delete.

Click =, then choose Delete to delete your selected resources or Delete All delete all subscriptions.
A dialog asks for confirmation that you want to delete the subscription.
To confirm removal, click Yes.

Your selected subscriptions are deleted from the subscriptions list, but any deployed instances of the
subscribed resource remain on the services.

Removing Subscribed Resources from the Deployments Subscriptions Grid

Subscriptions that are selected for deployment to a service group are deployed during synchronization.

You can remove subscriptions from the Live (Configure) > Subscriptions > Deployments panel, but
any that have actually been deployed to services remain deployed until someone removes them.

To remove resources from the Deployments tab Subscriptions panel:

1.
2.

Go to (Configure) > Subscriptions > Deployments

In the Groups panel, select a group.

Subscribed resources, if any, are listed in the Subscriptions panel.
In the Subscriptions panel, click =.

A dialog requests confirmation that you want to delete the resource from the service group. The
resource is removed from the Deployments tab Subscriptions panel, but is not removed from services
on which it is deployed.

Subscribe and Unsubscribe to a Resource

When you subscribe to resources, you will receive notification when new versions of the resources are
available.

To subscribe to a resource:

Go to (Configure) > Live Content.

1.

2. In the Search Criteria panel, specify search criteria and click Search.

3. Select one or more resources and click ™ Subscribe
A confirmation dialog is displayed: By subscribing to these resources, you are indicating that you
wish to receive notification when new versions are available.

4. To confirm that you want to subscribe to the resource, click OK.
The resource is added to the subscriptions managed in the Subscriptions tab and is available for
deployment in the Deployments tab.
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When unsubscribing from a resource, you have the option to leave the resource on services on which it is
deployed or to remove it from services.

To unsubscribe from a resource:

1. Open a detailed view of a resource in one of the following ways:

Perform a search, - (Configure) > Live Content > enter search criteria, then select the
resource in the Matching Resources panel, then click = Details

View subscriptions, (Configure) > Subscriptions, select the resource from the Subscriptions
list, then click =/ Details

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS

. Download A\ Subscribe B, Deploy

AWS Security Hub Log Collector Configuration

Log Collector
2020-07-28 6:17 PM
Jpdatec 2020-07-29 7:52 AM
Log Collector configuration content for event source AWS Security Hub

1.2

2. With the detailed view of a resource displayed. click % Unsubscribe .

A confirmation dialog is displayed.
Unsubscribe Resource?

You will no longer be notified of new updates to this
resource.

Resource will still be installed unless you manually remove it.

Cancel Unsubscribe Unsubscribe and Remove

3. Do one of the following:

¢ To confirm that you want to unsubscribe from the resource and leave it on the services where it is
deployed, click Unsubscribe.

¢ To confirm that you want to unsubscribe from the resource and remove it from the services where
it is deployed, click Unsubscribe and Remove from Services.

e To close the dialog without unsubscribing, click Cancel.

The selected action is applied.
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Viewing Subscribed Resources Selected to Deploy on Services

In the (Configure) > Subscriptions > Deployments tab you can view subscribed resources that
have been selected for deployment on services.

To view subscribed resources that have been selected for deployment on services:

In the Groups panel, select a group, and expand it to view services in the group. The resource
subscriptions selected for deployment are listed in the Deployments tab Subscriptions panel.
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Miscellaneous Live Services Procedures

This section describes several other procedures.

Displaying Resource Details in Live Resource View

After you select a resource (in the Live Resource View), you can view its detailed information.

To open a separate tab in the Live Resource view with details of a selected resource, do one of the

following:

o If you are viewing the results in Show Results > Detailed view, click the resource type icon or the

resource name.

NETWITNESS

LIVE CONTENT

Search Criteria

Keywords

Category
[CFEATURED
» CITHREAT
» CJIDENTITY
» CJASSURANCE
» [1OPERATIONS
I SPECTRUM
[IMALWARE ANALYSIS
Resource Types

Malware Rules @  Log Collector @

Medium

Required Meta Keys

SUBSCRIPTIONS

Investigate

CAPTURE POLICIES

Respond Users Hosts Files Dashboard Reports

POLICIES INCIDENT RULES

Matching Resources

& Show Results | | 3 Package
=s¢ RSA Malware PE Artifacts
~‘A pe Malware Rules updated 2018-05-04 11:11 PM vers 0.2 size 74.5 KB subs

Yara 10Cs which statically analyze Windows PE file artifacts for signs of malware.

=¢ RSA Malware PE Packers
ated 2013-11-21 9:07 PM version 0.1 size 93.97 KB
Yara I0Cs which statically analyze Windows PE files to identify Common Packers

e Malware Rules

RSA Malware PDF Artifacts
lated 2013-11-21 9:07 PM 0.1 size 587 B subs
Yara 10Cs which statically analyze PDF file artifacts for signs of malware

pe Malware Rules

McKesson HPF Log Collector Configuration
2d 2017-09-13 5:09 PM version 0.2 size 1.42 KB
Log Collector configuration content for event source McKesson HPF

ve Log Collector
@ event analysis, operations, log analysis

SAP ERP Central Component Log Collector Configuration
2017-09-13 5:10 PM on 0.2 size 1.24 KB subs
Log Collector configuration content for event source SAP ERP Central Component

™ cvant analhcic

191 Matching Resources

pe Log Collector updat

Anaratinne lna anakucic

INCIDENT NOTIFICATIONS

admin v

ESA RULES CUSTOM FEEDS LOG PARSER RULES

o If you are viewing the results in Show Results > Grid view, double-click a resource or select a

Deploy Content

73



Live Services Management Guide

resource and click Details.

NETWITNESS

LIVE CONTENT

Search Criteria

Keywords

Category
[JFEATURED
» CJTHREAT
» CJIDENTITY
» [JASSURANCE
» (] OPERATIONS
[JsPECTRUM

[ MALWARE ANALYSIS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:
Start Date End Date

Resource Modified Date:

SUBSCRIPTIONS

Investigate

Downloading a Resource

CAPTURE POLICIES POLIC

Respond Users Hosts Files

INCIDENT RULES

Matching Resources

[E5] Show Results |

Subscribed Name Created

[ no RSA OSINT IP Threat Intel F...

] no RSA OSINT Non-IP Threat In...

[ no Powershell Runs Command...

[ no Runs ACL Management Tool
no AWS Security Hub Log Colle...
no NWFL_fw:outbound-networ...

[ no 15027002 - Compliance Rep.
no Direct Login By A Watchlist ..
no 11.3 Endpoint Indicators by...

[ no RSA Certificate Manager Lo...

[ no Top Outbound Source IP

[ no Runs Chained Command S...
no Enumerates Local Groups

[ no SecurlD Cloud Device Regis...
no File Transport over ICMP

[ no fingerprint_job

[ no Cisco Ironport ESA Log Coll...
no HyTrust
no Bit9 Log Collector Configur...

[ no Event Viewer Executes Unc...
no Microsoft Audit Collection S...

663 Matching Resources

2020-09-10 7:53 PM
2020-09-10 7:53 PM
2019-04-10 2:23 PM
2019-04-10 2:29 PM
2020-07-28 6:17 PM
2012-04-23 12:09 PM
2014-06-17 2:45 PM
2018-03-27 2:01 PM
2019-04-10 1:51 PM
2013-11-22 6:35 AM
2014-07-24 10:56 AM
2019-04-10 2:30 PM
2019-04-10 2:16 PM
2019-04-17 5:54 AM
2014-07-21 5:31 PM
2013-09-12 2:24 PM
2013-11-22 6:13 AM
2014-02-14 3:34 AM
2013-11-226:11 AM
2019-04-10 2:17 PM

2014-02-14 3:41 AM

Dashboard Reports

INCIDENT NOTIFICATIONS

| 3§ Package

Updated

2022-09-06 4:30 AM
2022-09-06 4:30 AM
2020-01-23 4:21 PM
2019-04-10 3:09 PM
2020-07-29 7:52 AM
2017-11-11 3:37 AM
2017-09-23 5:41 AM
2018-07-24 5:31 PM
2019-04-10 2:02 PM
2017-09-13 11:40 AM
2017-09-23 5:49 AM
2019-04-103:10 PM
2019-04-10 3:06 PM
2019-04-17 5:56 AM
2017-11-11 3:37 AM
2017-09-23 5:37 AM
2017-09-13 11:37 AM
2017-09-13 11:07 AM
2017-09-13 11:37 AM
2019-04-10 3:07 PM

2020-05-04 2:06 PM

You can download a single resource from the Live Resource View.

To download a resource:

1. Goto

(Configure) > Live Content.

ESA RULES

Type
Feed

Feed

Application Rule
Application Rule
Log Collector
Application Rule
NetWitness Report
Event Stream Anal...
NetWitness Rule
Log Collector
NetWitness Rule
Application Rule
Application Rule
Application Rule
Application Rule
Lua Parser

Log Collector

Log Device

Log Collector
Application Rule

Log Device

admin v

CUSTOM FEEDS

Description

This feed contains IP Address (IPv
This feed contains Non-IP Addres
Powershell running command pr:
Running ACL management tool c:
Log Collector configuration conte
NWFL App Rule to support Inforn
ISO 27002 establishes guidelines
A successful interactive or remote
Number of risk indicators associe
Log Collector configuration conte
Summarizes a list of outbound sc
Running chained command shell
Enumeration of local groups can
Raises an alert when RSA SecurlC
Detects files transported over ICh
Identifies windows job task schec
Log Collector configuration conte
Log device content for event sour
Log Collector configuration conte
Event viewer executing uncomme

Log device content for event sour ¥

2. In the Search Criteria panel, enter the criteria needed to return the resource you want to download.

3. Select a single resource, then click = Details

4. Click .L Download

The resource is saved as a ZIP archive to your local Downloads folder.

Locating and Removing a Deployed Resource from Services

You can locate and remove a deployed resource from services from the Live Resource View.

To view a list of services on which a resource is deployed:

1. With a resource displayed in the Resource View, click @ Service Locator -

The Service Locator dialog is displayed.
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= Remaove

Services
O ,6{ Name ~
O n

2. Select one or more services in the Services list.

3. Click —.

ppliance19848 - Log Decoder

Type

Log Decoder

Cancel

The resource is removed from the selected services.

Showing Results as a List or in Detail

1. Select Show Results > Grid to change to grid results when viewing detailed results.

NETWITNESS

LIVE CONTENT

Search Criteria

Keywords

Category
[ FEATURED
» I THREAT
» CJIDENTITY
» CJASSURANCE
» [T OPERATIONS
[JsPECTRUM

[ MALWARE ANALYSIS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:
Start Date End Date

Resource Modified Date:

SUBSCRIPTIONS

Investigate

Searcl

CAPTURE POLICIES

Respond Users

POLICIES

Matching Resources

Show Results |

) subscribed Name

[ no RSA OSINT IP Threat Intel F...
no RSA OSINT Non-IP Threat In...
[ no Powershell Runs Command...
[ no Runs ACL Management Tool
[J no AWS Security Hub Log Colle...
0 no NWFL_fw:outbound-networ...
O no 15027002 - Compliance Rep...
L) no Direct Login By A Watchlist ...
no 11.3 Endpoint Indicators by...
no RSA Certificate Manager Lo..
[0 no Top Outbound Source IP
no Runs Chained Command S...
no Enumerates Local Groups
[0 no SecurlD Cloud Device Regis...
[0 no File Transport over ICMP
no fingerprint_job
[0 no Cisco Ironport ESA Log Coll...
[0 no HyTrust
no Bit9 Log Collector Configur...
[0 no Event Viewer Executes Unc...
[0 no Microsoft Audit Collection ...

663 Matching Resources

Hosts

INCIDENT RULES

Files

Created

2020-09-10 7:53 PM
2020-09-10 7:53 PM
2019-04-10 2:23 PM
2019-04-10 2:29 PM
2020-07-28 6:17 PM
2012-04-23 12:09 PM
2014-06-17 2:45 PM
2018-03-27 2:01 PM
2019-04-10 1:51 PM
2013-11-22 6:35 AM
2014-07-24 10:56 AM
2019-04-10 2:30 PM
2019-04-10 2:16 PM
2019-04-17 5:54 AM
2014-07-21 5:31 PM
2013-09-12 2:24 PM
2013-11-22 6:13 AM
2014-02-14 3:34 AM
2013-11-22 6:11 AM
2019-04-10 2:17 PM

2014-02-14 3:41 AM

Dashboard

Reports

INCIDENT NOTIFICATIONS

| 3 Package

Updated

2022-09-06 4:30 AM
2022-09-06 4:30 AM
2020-01-23 4:21 PM
2019-04-10 3:09 PM
2020-07-29 7:52 AM
2017-11-11 3:37 AM
2017-09-23 5:41 AM
2018-07-24 5:31 PM
2019-04-10 2:02 PM
2017-09-13 11:40 AM
2017-09-23 5:49 AM
2019-04-10 3:10 PM
2019-04-10 3:06 PM
2019-04-17 5:56 AM
2017-11-11 3:37 AM
2017-09-23 5:37 AM
2017-09-13 11:37 AM
2017-09-13 11:07 AM
2017-09-13 11:37 AM
2019-04-10 3:07 PM

2020-05-04 2:06 PM

ESA RULES

Type
Feed

Feed

Application Rule
Application Rule
Log Collector
Application Rule
NetWitness Report
Event Stream Anal...
NetWitness Rule
Log Collector
NetWitness Rule
Application Rule
Application Rule
Application Rule
Application Rule
Lua Parser

Log Collector

Log Device

Log Collector
Application Rule

Log Device

admin v

CUSTOM FEEDS

Description

This feed contains IP Address (IP\
This feed contains Non-IP Addres
Powershell running command pri
Running ACL management tool c:
Log Collector configuration conte
NWFL App Rule to support Inform
1SO 27002 establishes guidelines
A successful interactive or remote
Number of risk indicators associz
Log Collector configuration conte
Summarizes a list of outbound sc
Running chained command shell
Enumeration of local groups can
Raises an alert when RSA SecuriC
Detects files transported over ICA
Identifies windows job task schec
Log Collector configuration conte
Log device content for event sour
Log Collector configuration conte
Event viewer executing uncommc

Log device content for event sour ¥
>
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2. Select Show Results > Detailed to change to detailed results when viewing grid results.

NETWITNESS

Investigate

Respond Users Hosts Files Dashboard

Reports admin w
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES
Search Criteria Matching Resources
Keywords 3 Show Results | | 3 Package
RSA Malware PE Artifacts
Category e Malware Rules updated 2018-05-04 11:11 PM 10.2 size 745 KB sub no
[ FEATURED Yara 10Cs which statically analyze Windows PE file artifacts for signs of malware.
» [ THREAT
» CJIDENTITY =5 RSA Malware PE Packers
NS a8 Malware Rules updated 2013-11-21 9:07 PM v 0.1 size 93.97 KB no
ASSURANCE
Yara 10Cs which statically analyze Windows PE files to identify Common Packers
» CJOPERATIONS
[CISPECTRUM 7 RSA Malware PDF Artifacts
] MALWARE ANALYSIS B 1) pe Malware Rules updated 2013-11-21 9:07 PM version 0.1 size 587 B ed no
Yara 10Cs which statically analyze PDF file artifacts for signs of malware
Resource Types
Malware Rules @  Log Collector @ 4y, McKesson HPF Log Collector Configuration
5 he Log Collector updated 2017-09-13 5:09 PM 2 size 1.42 KB s no
Medium Log Collector configuration content for event source McKesson HPF
@ event analysis, operations, log analysis
Required Meta Keys 4y SAP ERP Central Component Log Collector Configuration
£ Log Collector ated 2017-09-13 5:10 PM 2 size 1.24 KB subs no
2 Log Collector configuration content for event source SAP ERP Central Component
B auont analucic nnaratinne Ino analucic =
191 Matching Resources

Viewing Resource Details

You can display detailed information about a subscribed resource in the Resource View.
To view details:
1. In the Subscriptions tab, select a single subscription.

2. Click [E Details
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The details of the resource are displayed in the Resource View.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

LIVE CONTENT S CRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES

¥ Download 3\ Subscribe €3 Service Locator

Runs ACL Management Tool

Application Rule
cate 2019-04-10 2:29 PM
2019-04-10 3:09 PM

Running ACL management tool can be an indication of someone trying
to run multiple malicious commands needed to perform multi-stage
attack to exploit the system, which can be further used to gain access,
to do lateral movement or to gain elevated privileges.

VERSIONS SUPPORTED
* NetWitness Platform 11.3 and higher

DEPENDENCIES
* NetWitness Endpoint Server

GENERATED META KEYS
* analysis.file = runs acl management tool

0.1

199 bytes
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References
This topic is a collection of references, which describe the user interface and more detailed information
about how Live works in NetWitness. These topics are presented in alphabetical order.
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Live Configure View

In the Live Configure view, NetWitness provides integrated tools for managing Live resources. You can
manage resource subscriptions, deployments to services and discontinued resources. The required role to
access this view is Configure Live Resources. For a high-level description of how to use the different
views in NetWitness Live, please read Live Services Management.

To access this view, navigate to (Configure) > Subscriptions. The view has three tabs:
Deployments Tab, Subscriptions Tab, and Discontinued Resources Tab.
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Deployments Tab

The Deployments tab provides a user interface in the Live Configure view for:
¢ Viewing subscribed resources that are selected for deployment on services in a service group.
¢ Selecting subscribed resources to deploy to services in a service group.

* Removing resources that are selected for deployment on services in a service group.

The resources listed here are not deployed immediately after adding to a service group. Instead the
subscribed resources are pushed to the services when NetWitness synchronizes with NetWitness Live.
The synchronization schedule is configured in the Live Configuration panel. Additionally, you can

synchronize immediately in the (Configure) > Subscriptions > Deployments tab.

Likewise, resources deleted from the Deployments panel are not deleted from service where they have
been deployed. To delete resources from services, delete them in the Live Resource View.

The required permission to access this view is Manage Live Resources.
To access this view:

1. Goto (Configure) > Subscriptions.
The Subscriptions tab is displayed.
2. Click the Deployments tab.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES

Subscriptions EEIlYNIeM Discontinued Resources

Groups Subscriptions
Name Address Type | 8

] Name Created Updated Discontinued Type Description

The Deployments tab has two panels: Groups and Subscriptions.
Groups Panel

The Groups panel is a static display of configured service groups that were created in the Administration
Services view. Selecting a group in the Groups panel populates the Subscriptions panel with a list of
subscriptions that are selected for deployment on the services in the service group.

e

Name Displays the service group name. Clicking the plus sign displays a nested list of services in the group.

Address Displays the IP address of each service in the group.
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e Jowmn

Type

Displays the type of service.

Subscriptions Panel

The following table describes the features in the Subscriptions panel.

e e

Name
Created
Updated
Type

Description

Click + to open a dialog that lists subscriptions that were added in the Live Search view or in the
Live Resource view and are available for deployment.

Click = to delete the selected subscriptions from the deployment list for service group.

Click =~ to synchronize your resources to the latest versions available on Live.
Displays name of the resource.

Displays date and time that the resource was created.

Displays date and time that the resource was last updated.

Displays type of resource.

Displays description of the resource.
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Subscriptions Tab

Subscriptions are NetWitness Live resources to which you subscribed in the Live Search view or Live
Resource view. When you subscribe to a resource, you agree to receive updates on a regular basis from
NetWitness Live. The choices made in the Live Configuration panel determine the synchronization
frequency and also whether you receive update notifications through email. In addition, if you don't want
to wait for the next update, you can force an immediate synchronization.

The Subscriptions tab provides a way to manage subscriptions. Each resource to which NetWitness is
subscribed is listed in this tab.

In the Subscriptions tab, you can:
* View all resources to which this NetWitness instance is subscribed.
¢ Open a detailed view of a subscription in the Live Resource View.

¢ Delete a subscription.

Note: Subscribing to a resource does not deploy the resource to any services. To deploy one or more
subscribed resources, go to the Deployments tab. To deploy a single resource manually, use the
Deploy option in the Resource View.

The required permission to access this view is Manage Live Resources.

To access this view, in the main menu, selec (Configure) > Subscriptions. The Subscriptions tab
is displayed.

NETWITNESS Files

LIVE CONTENT SUESCRIPTIONS CAPTURE POLICIES MCIDENT RULES NMCIDENT NOTIFICATIONS

LG IVIGLEE Deployments  Discontinued Resources

- | :@:
0| Name Type Version Discontinued Updated Description
yp P p
O [IMalware IP List Decoder Feed 0.1567 no 2017-07-17 12:45 AM List of ip addresses commonly associated ...
[0 [IMalware Domains Decoder Feed 0.869 no 2017-07-19 1:02 AM List of domains associates with malware so...

The Subscriptions tab has a toolbar and a grid.

Toolbar

This table describes the options available in the toolbar.

e Towamn

Deletes the selected subscriptions.

Details  Displays the details of a single subscribed resource in the Resource View.
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Grid

Check the Live Server for the latest discontinued resources.

™

Name
Type
Version

Discontinued

Updated

Description

Selects subscribed resources to view in detail or delete. You can view details for a single
resource. You can delete one or more resources from the subscribed resources, in effect
unsubscribing.

Displays name of the subscribed resource.

Displays type of subscribed resource.

Displays version of the subscribed resource.

Indicates the status of the discontinued resources for the subscribed resource.
Yes - Resource is discontinued.
No - Resource is not discontinued.

-- - The Live Server is not checked for the discontinued resources.
Displays date and time when the subscribed resource was last updated.

Displays description of the subscribed resource.
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Discontinued Resources Tab

The Discontinued Resources tab provides a user interface in the Live Configure view:

e Scan the services for the discontinued resources.

e Remove the discontinued resources from any service or service group.

Note: Discontinued content still appears. With discontinued content there just won’t be any updates,
and users won’t see these items when they search in Live, unless they check the Include Discontinued
Resources box while searching.

In the RSA Content space on NetWitness Community, you can view the complete, up-to-date list of
discontinued resources (Discontinued Content). For each resource, there is a description of why it was
discontinued. Use these details to determine whether or not to remove a discontinued resource from your
installation. .

The required permission to access this view is Manage Live Resources.

To access this view:

1. Goto (Configure) > Subscriptions.
The Subscriptions tab is displayed.
2. Click the Discontinued Resources tab.

The Discontinued Resources tab is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES

Ve gloliloly SR e Il Discontinued Resources

Groups Discontinued Resources on Service
BEI1C -
Name Address Type ! Name Type Version Discontinued Updated Description

No Service was found to have
discontinued resources

The Discontinued tab has two panels: Groups and Discontinued Resources on Service.

Groups Panel

The Groups panel is a static display of configured service groups that were created in the Admin
Services view. Selecting a group in the Groups panel populates the Discontinued Resources panel with a
list of discontinued resources which are deployed on the selected service or service group.
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E

~
L

Name

Address

Type

Click the button to scan the services for a discontinued resource.

Displays the current status of the discontinued resources on a service.

Note: The status of a service may change while the services are being scanned.

Displays service group name. Clicking the plus sign displays a nested list of services in the group.

Displays IP address of each service in the group.

Displays type of service.

Discontinued Resources on Service Panel

The following table describes the features in the Discontinued Resources on Service panel.

N e N

Name
Type
Version

Discontinued

Updated

Description

Click the button to delete the selected resources from the service or service group.

This is the name of the resource.
This is the type of resource.
Version of the discontinued resource.

Indicates the status of the discontinued resources for the subscribed resource.
Yes - The resource is discontinued.
No - The resource is not discontinued.

--- The Live Server is not checked for the discontinued resources.
Displays date and time that the resource was last updated.

Displays description of the resource.
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Live Feeds View
Use the Live Feeds View to:
¢ Create custom feeds.

e Create identity feeds.
e Edit feeds.

The required role to access this view is Manage Devices.

To access this view, navigate to (Configure) > Custom Feeds.
This is an example of the Feeds view.

NETWITNE

admin
LIVE COMTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES MNT MOTIFICATIONS 3 5 CUSTOM FEEDS
+ [
O Name Trigger Disk Usage Created Last Run Time Status Progress
O TEST Once 2019-07-1313:30:36  2019-07-13 13:30:36  Completed C—
O TEST2 Once 2019-07-1313:50:33  201%-07-13 13:50:32  Completed C—
O e Once 2019-07-14 04:16:51  2019-07-1404:16:51  Completed [ ]
O onlydom Once 2018-07-14 04:21:37  2019-07-1404:21:37  Completed e
O PCAP Once 2019-07-1409:30:49  2019-07-14 02:30:49  Completed C—

The Feeds tab has a toolbar and a grid.
Toolbar

This table describes the options in the toolbar.
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=%

» @ N

Feeds Grid

Initiates the creation of a custom or identify feed by displaying the Setup Feed dialog is displayed.

Setup Feed

(® Custom Feed

) Identity Feed

Cancel

e Custom Feed opens the Configure a Custom Feed wizard.

¢ |dentity Feed opens the Configure Identity Feeds wizard.

Deletes the feed that you selected.

Opens the Configure Custom Feed or Configure Identity Feed wizard for the feed that you selected

(see Editing a Feed.

Start or resume data feed.

Stop or pause data feed.

This table describes the columns in the grid.

[

Name

Trigger

Created
Disk Usage

Last Run
Time

Status

Progress

Selects a feed.

Name of the feed.

Note: You can now use special characters to define the name of the custom feed.

Displays how often the feed runs which is determined by what you defined in Feed Task Type when
the feed was created.

Displays date and time when the feed was created.
Displays the MongoDB storage size used by the TAXII feed.

Displays date and time when the feed was last run.

The status of the feed.

Progress bar.
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Live Resource View

The Live Resource View shows a detailed view of a selected resource, and has the following options:
* Download the resource.

* Subscribe or unsubscribe the resource.

» Deploy the resource to services.

e Locate services on which the resource is deployed and remove the resource from services.

The required permission to access this view is View Live Resource Details.

To access this view, do one of the following:
1. Goto (Configure) > LIVE CONTENT > Search Criteria.

2. In the Live Search view, Detailed Results, click the resource type icon or the resource name.

3. In the Live Search view, Grid Results, double-click a resource or select a resource and click Details.

This is an example of the Resource view.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports [ admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS

&, Download 3\ Subscribe [ Deploy €3 Service Locator

Runs ACL Management Tool

Application Rule
2019-04-10 2:29 PM
2019-04-10 3:09 PM

Running ACL management tool can be an indication of someone trying
to run multiple malicious commands needed to perform multi-stage
attack to exploit the system, which can be further used to gain access,
to do lateral movement or to gain elevated privileges.

VERSIONS SUPPORTED
* NetWitness Platform 11.3 and higher

DEPENDENCIES
* NetWitness Endpoint Server

GENERATED META KEYS
* analysis.file = runs acl management tool

0.1

199 bytes

The Live Resource View has a detailed view of a single resource and a toolbar.

Resource Details

The following table describes the elements in the Resource Details section.
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Resource
Type Icon

Name

Type
Created
Updated
Description
Version in
production
Size

Required
Resources

Tagged as

L

Required
Meta Keys

Generates
Meta Values

Permissions

A graphic representation of the resource type, for example F

The name of the resource, for example, fingerprint_office_lua

The type of resource, for example, RSA Lua Parser,

The date the resource was created, for example, 2013-09-15 02:16 PM.
The date the resource was last updated, for example, 2013-09-15 02:16 PM

The description of the resource, for example, Identifies Microsoft Office 95, 2007 Word, Excel, and
PowerPoint documents,

The version of the resource, for example, 0.1,

The size of the resource, for example, 9-079 KB,

A list of resources on which this resource depends, for example, NetWitness Lua Library. Clicking a
resource replaces the currently displayed details with the details of the one you clicked.

The tags that apply to the resource. In the example, the tags are featured, informational. Clicking a
tag opens the Live Search View with the search narrowed to match resources with that tag.

The meta keys [ that apply to the resource. In the example, there are no meta keys required. Clicking a

meta key opens the Live Search View with the search narrowed to match resources with that meta key.

The meta values E that the resource generates. In the example, there are no meta values generated.

Clicking a meta value opens the Live Search View with the search narrowed to match resources with that
meta value.

The permissions required for the resource.

Resource View Toolbar

This table describes the Live Resource view toolbar options.

N

Download

This option downloads the resource currently displayed in the Resource
.L Download View_p y cispiay
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T

Subscribe or ; This option subscribes to or unsubscribes from the resource currently
Unsubscribe :-'l-"i Subscribe displayed in the Resource View.

N Unsubscribe Clicking Subscribe opens a dialog notifying that you are agreeing to

receive notification when the selected resources are updated. You can
cancel or click OK.

e Clicking Unsubscribe asks for confirmation that you want to stop
receiving notification when the selected resources are updated. You
can then choose to cancel or you can click Unsubscribe or
Unsubscribe and Remove, which also removes the resource from
services on which it is deployed.

Deploy |_;-|,’ Deploy This option proyides awayto deploy the resource currently displayed in
the Resource View. Clicking Deploy opens the Manual Resource
Deployment dialog.

Service Locator ¢ geryice Locator 1 Nis Option displays a list of services on which the currently displayed
resource is deployed. You can remove the resource from all services or
selected services.
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Live Search View

The Live Search view provides the ability to browse the configured Live CMS for resources. Once
matching resources are found, you can view details, subscribe to resources, and deploy resources to

services and service groups.
This is an example of the Search view.

NETWITNESS Users Hosts Files

Investigate

Resp

LIVE CONTENT JBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES

Search Criteria Matching Resources

Keywords Show Results |
Subscribed Name Created
Category no RSA OSINT IP Threat Intel F.
[ FEATURED [ no RSA OSINT Non-IP Threat In...
» LI THREAT [ no Powershell Runs Command...
» CJIDENTITY no Runs ACL Management Tool
» [ ASSURANCE [0 no AWS Security Hub Log Colle...
» (] OPERATIONS [ no NWFL_fw:outbound-networ..
[CISPECTRUM no 15027002 - Compliance Rep...
[ MALWARE ANALYSIS [ no Direct Login By A Watchlist ...
no 11.3 Endpoint Indicators by...
Resource Types
no RSA Certificate Manager Lo...
[ no Top Outbound Source IP
Medium no Runs Chained Command S...
v no Enumerates Local Groups
. [J no SecurlD Cloud Device Regis...
Required Meta Keys
[ no File Transport over ICMP
no fingerprint_job
Generated Meta Values -
no Cisco Ironport ESA Log Coll...
[ no HyTrust
Resource Created Date:
. . no Bit9 Log Collector Configur...
Start Date End Date -
no Event Viewer Executes Unc...
Resource Modified Date: ol no Microsoft Audit Collection S...

663 Matching Resources

2020-09-10 7:53 PM

2020-09-10 7:53 PM

2019-04-10 2:23 PM

2019-04-10 2:29 PM

2020-07-28 6:17 PM

2012-04-23 12:09 PM

2014-06-17 2:45 PM

2018-03-27 2:01 PM

2019-04-10 1:51 PM

2013-11-22 6:35 AM

2014-07-24 10:56 AM

2019-04-10 2:30 PM

2019-04-10 2:16 PM

2019-04-17 5:54 AM

2014-07-21 5:31 PM

2013-09-12 2:24 PM

2013-11-22 6:13 AM

2014-02-14 3:34 AM

2013-11-226:11 AM

2019-04-10 2:17 PM

2014-02-14 3:41 AM

Dashboard Reports

INCIDENT NOTIFICATIO

| 3 Package

Updated

2022-09-06 4:30 AM
2022-09-06 4:30 AM
2020-01-23 4:21 PM
2019-04-10 3:09 PM
2020-07-29 7:52 AM
2017-11-11 3:37 AM
2017-09-23 5:41 AM
2018-07-24 5:31 PM
2019-04-10 2:02 PM
2017-09-13 11:40 AM
2017-09-23 5:49 AM
2019-04-10 3:10 PM
2019-04-10 3:06 PM
2019-04-17 5:56 AM
2017-11-11 3:37 AM
2017-09-23 5:37 AM
2017-09-13 11:37 AM
2017-09-13 11:07 AM
2017-09-13 11:37 AM
2019-04-10 3:07 PM

2020-05-04 2:06 PM

ESA RULES

Type
Feed

Feed

Application Rule
Application Rule
Log Collector
Application Rule
NetWitness Report
Event Stream Anal...
NetWitness Rule
Log Collector
NetWitness Rule
Application Rule
Application Rule
Application Rule
Application Rule
Lua Parser

Log Collector

Log Device

Log Collector
Application Rule

Log Device

admin v

CUSTOM FEEDS

Description
This feed contains IP Address (IPv
This feed contains Non-IP Addres
Powershell running command pr
Running ACL management tool c:
Log Collector configuration conte
NWFL App Rule to support Inforn
1SO 27002 establishes guidelines
A successful interactive or remote
Number of risk indicators associc
Log Collector configuration conte
Summarizes a list of outbound sc
Running chained command shell
Enumeration of local groups can
Raises an alert when RSA SecurIC
Detects files transported over ICh
Identifies windows job task schec
Log Collector configuration conte
Log device content for event sour
Log Collector configuration conte
Event viewer executing uncommc

Log device content for event sour ¥
»

The Live Search view has a panel for specifying search criteria and a panel that displays matching
resources. The Search Criteria panel is collapsible to provide more width for viewing the Matching

Resources panel.

Search Criteria Panel

This is an example of the Search Criteria panel.
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Search Criteria

Keywords

Category
[CJFEATURED

» CITHREAT

» CJIDENTITY

¥ CJASSURANCE

» CJ OPERATIONS

Resource Types
Medium

Required Meta Keys
Generated Meta Values
Resource Created Date:

Start Date End Date

Resource Modified Date: h

The following table provides descriptions of the Search Criteria panel features.

Description

Keyword(s) Enter a keyword or keywords to browse for resources that have the keyword in the resource
name or the resource description. You can use wildcards when you enter a keyword.

Category The categories mirror the hierarchical Investigation Model that NetWitness uses to organize
resources. The purpose of the Investigation model is to deliver an accurate path to information

security incident response. For more information, see the [nvestigation Model topic in the
NetWitness Content space on NetWitness Community.
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Resource Types

Medium

Select resources types from the drop-down list to filter resources by type of resource. Possible
values are:

¢ Advanced Analytics (Warehouse)
e Application Rule

e Bundle

¢ Correlation Rule

¢ Event Stream Analysis Rule
e Feed

e FlexParser

* Investigation Column Group
¢ Investigation Meta Group

¢ Investigation Profile

¢ Log Collector

e Log Device

* Lua Parser

e Malware Rules

e NetWitness List

¢ NetWitness Report

¢ NetWitness Rule

e (Version 11.5 and later) Health and Wellness Dashboards

e (Version 11.5 and later) Health and Wellness Monitors

Note: Some rules that have been deployed to an earlier version of NetWitness may not deploy or
execute on NetWitness 11.x. For more information, see the Troubleshooting Live Services.

Select one or more mediums from the drop-down list to search for content based on the meta
data source.

Available values for medium are as follows:

e endpoint: for NetWitness 11.3 and later): applied to content that uses meta
derived from endpoint agent and endpoint server data

 log: applied to content that uses meta derived from log data
e packet: applied to content that uses meta derived from network packets

* log and packet: applied to content that correlates meta derived across log and
packet data
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Tags Select meta tags from the drop-down list to browse based on how the meta is tagged. For example, to
browse resources for a Log Decoder, select the netwitness for logs tag. Alternatively, you can click a
tag in the Matching Resources panel to insert that tag in this field.

Required Meta Enter a specific meta key; for example, threat.source, Alternatively, you can click a meta key in the
Key(s) Matching Resources panel to insert that tag in this field.

Generated Meta  Enter a generated meta value; for example, netwitness, Alternatively, you can click a generated meta
Value(s) key in the Matching Resources panel to insert that tag in this field.

Research Specify a date range during which resources were created. For example, to browse resources that were
Created Date created between January 1 and January 4, you select January 1 as the start date and January 4 as the

end date. You must enter dates in mm/dd/yyyy format or you click and pick dates from a calendar.

Research Specify a date range during which resources were modified. For example, to browse resources that

Modified Date were modified between January 1 and January 4, you select January 1 as the start date and January 4 as
the end date. You must enter dates in mm/dd/yyyy format or you click and pick dates from a
calendar.

Search Click Search to send the search request to the Live server. More specific search criteria return

matching resources more quickly.

Cancel Click Cancel to cancel the search in progress.

Include Check Include Discontinued Resources to include the discontinued resources in the search
Discontinued result. For an up-to-date list of resources that have been discontinued, see the Discontinued
Resources Content topic.

Matching Resources Panel

The Matching Resources panel displays search results based on the selections made in the Search
Criteria panel. Results are initially displayed in a grid, but you can switch between two Show Results
options: Detailed or Grid.

Detailed Results

In the detailed results, you can click a tag, meta key, or resource meta value to auto fill the Search
Criteria panel and pivot the search results.

The following table describes the elements in the detailed results.

rean ommn

Resource |
Type Icon A graphic representation of the resource type. For example
Name The name of the resource, for example, Group Management.

Note: (Discontinued) is displayed next to the resource name if a resource is discontinued.
Type The type of the resource, for example, Rule.
Updated The date when the resource was last updated, for example, 2015-09-15 4:27 PM.
Version The version of the resource, for example, 0.1.

94 Deploy Content


https://community.netwitness.com/t5/netwitness-platform-threat/discontinued-content/ta-p/677879
https://community.netwitness.com/t5/netwitness-platform-threat/discontinued-content/ta-p/677879

Live Services Management Guide

o Jowemn

Size

Subscribed

Description

Tags

Meta Keys

Resource
Meta Values

Grid Results

The size of the resource, for example, 153 B.

Subscription status:

¢ vyes: This NetWitness instance is subscribed to this content resource.

¢ no: This NetWitness instance has not subscribed to this content resource.
The description of the resource, for example, Compliance Rule-Group Management.

The tags that apply to the resource. Clicking a tag narrows the search to resources with that tag. For
example, *

The meta keys that apply to the resource. Clicking a meta key narrows the search to resources with

that meta key. For example, ‘f

The meta values generated by the resource. Clicking a meta value narrows the search to resources

that generated the meta value. For example, E .

In the grid view, you can select one or more resources and use additional options in the toolbar to view
the details of a single resource, subscribe to resources, and deploy resources.

The following table describes the elements in the grid results.

T

Subscribed

Name

Created

Updated

Type

Discontinued

Description

Subscription status:

¢ yes: This NetWitness instance is subscribed to this content resource.

¢ no: This NetWitness instance has not subscribed to this content resource.

The name of the resource, for example, Group Management.

Note: The resource name is displayed in red color if it is discontinued.

The date when the resource was created, for example, 2015-08-12 3:11 PM,
The date when the resource was last updated, for example, 2015-09-15 4:27 PM,

The type of the resource, for example, Rule,

The status of the discontinued resources:
e yes: The resource that matches the search criteria is discontinued

e no: The resource is not discontinued
e --: The Live Server is not checked for the discontinued resources

The description of the resource, for example, Compliance Rule-Group Management.

Toolbar

Deploy Content

95



Live Services Management Guide

e o

Show Resuli This menu offers two ways to view search results: Detailed and Grid,

Detzils This option applies to a single selected resource. Clicking Details opens the selected resource in the Live
Resource view.

:@: Deploy This option applies to one or more selected resources.

N Subscribe This option applies to one or more selected resources. Clicking Subscribe opens a dialog that
: asks for confirmation that you want to receive notification when the selected resources are
updated.

& Packa ge - This menu offers two packaging functions for the selected resources:

e Create: creates a resourceBundle.zip file that contains the selected resources and opens a
dialog in which you can either:

e open the file, or
o save the file for subsequent deployment.

¢ Deploy: opens the Deployment Wizard, in which you can choose a resourceBundle.zip file
and deploy it.

See Also

* For more information on Deployment ( ., Deplay ), see Find and Deploy Live Resources.

* For more information on Deploying a Package (K Package ), see the Resource Package
Deployment Wizard,.
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Live Search Content View

The Live Search Content view provides the ability to search the configured Live CMS for content. Once
matching content are found, you can view the details, and download the content.

This is an example of the Search Content view.

NETWITNESS

& Content

View New, recently updated and community content details here.

SOURCE

NetWitness

Content Showing New Content (12) Timezone : GMT+0530 Asia/Calcutta

NAME } CREATED * UPDATED & TYPE & MIN PLATFORM VERSION 4 DESCRIPTION

O New

Recently Updated 07-Sep-2022 18:... 07-Sep-2022 18:... Application Rule LG Detects a Windows command and scripting interpreter exe.

30-Aug-202218:..  30-Aug-202223..  Application Rule 115 Identifies User Account Control (UAC) bypass attempts usi..
Search Content
26-Aug-202219...  26-Aug-202219..  EventStreamAn... 115 When attempting to access 0365 environments, actors ma.
25-Aug-202222:..  25-Aug-202222..  Application Rule Al Versions In environments where admin privileges have already been. |
25-Aug202222:..  25-Aug-202222..  ApplicationRule Al Versions C2 communication for Quasar RAT uses a common SSL Cer..
25-Aug-202216...  25-Aug-202216..  Application Rule All Versions This rule helps to detect regsvr32.exe, rundii32.exe, and diIl.
25-Aug-202216...  25-Aug-202216..  Application Rule All Versions fodhelper (Features On Demand Helper) is an executable u..
25-Aug-202216....  25-Aug-202216:..  Application Rule All Versions Raspberry Robin, the LNK Worm, is commonly known tod...
25-Aug-202216:...  25-Aug-202216..  Application Rule Al Versions Adversaries can use the command prompt feature cmd/R <.
19-Aug-202222..  19-Aug-202222..  Application Rule Al Versions WhisperGate, a type of data wiping malware, is commonly ...

19-Aug-2022 22... 19-Aug-2022 22-... Application Rule Al Versions Towards it's final execution steps, WhisperGate, the data w..

19-Aug202222...  19-Aug202222..  Application Rule Al Versions WhisperGate, a type of data wiping malware, is commonly ..

NETWITNESS

&) Content

SOURCE: | Community View , recently updated and community content details here.

Only Opensource
Showing Filtered Content (2) Timezone : GMT+0530 Asia/Calcutta
Content
NAME } CREATED * UPDATED & TYPE & MIN PLATFORM VERSION 4 DESCRIPTION }
New

O Recently Updated v 19-Aug202222..  19-Aug-202222..  ApplicationRule NA Data Wiping Malwares may partially or completely overwr...

Search Content 18-Aug-2022 21:... 18-Aug-2022 21.... Application Rule Detects a successful ProxyShell exploitation attack (CVE-2...|

The Live Search Content view has a panel for selecting the source and specifying search content. The
matching content are displayed on the right panel.

The following table provides descriptions of the Live Search Content panel features.

Description

NetWitness Select NetWitness from the Source drop-down menu to search for the content that is
provided by NetWitness Platform XDR Live.

Community  Select Community from the Source drop-down menu to search for the content
collected and retrieved from third party and open source communities.
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Only Select the Only Opensource checkbox to retrieve the content from the open-source
Opensource  communities.

Note: When the community is selected as the source, the Only Opensource option
will be displayed under the Search Content Panel to select and search for open
source-related content.

New Select New to retrieve the content which is created in the last 21 days.
Recently Select Recently Updated to retrieve the content which is updated in the last 21 days.
Updated

Search Content Panel

This is an example of the Search Content panel.

The following table provides descriptions of the Search Content panel features.

e o

Keywords Enter a keyword or keywords to browse for content that have the keyword in the
resource name or the resource description. You can use wildcards when you enter a
keyword.
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Resource Select resources types from the drop-down list to filter resources by type of resource.
Types Possible values are:

* Application Rule

e Feed

e Log Device

e Correlation Rule

e NetWitness Rule

e NetWitness Report

e Lua Parser

e Log Collector

e NetWitness List

e Malware Rules

» Event Stream Analysis Rule

e Advanced Analytics (Warehouse)
e Bundle

e Health and Wellness Dashboards
» Health and Wellness Monitors

* Investigate Profile

e Investigate Column Group

» Investigate Meta Group
Mediums Select one or more mediums from the drop-down list to search for content based on
the meta data source.
Available values for medium are as follows:
» endpoint: for 11.3 and higher): applied to content that uses meta derived from
endpoint agent and endpoint server data

» log: applied to content that uses meta derived from log data
o packet: applied to content that uses meta derived from network packets

 log and packet: applied to content that correlates meta derived across log and
packet data.

Tags Select meta tags from the drop-down list to browse based on how the meta is tagged.
For example, to browse content for a Log Decoder, select the netwitness for logs
tag.
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Platform Select one or more platform versions from the drop-down list to search for content
Versions based on the versions. For example, 11.5.

Required Enter a specific meta key. For example, threat.source,

Meta Keys

Generated Enter a generated meta value. For example, rsa-firstwatch.

Meta Values

Created Date  Specify a date range during which content were created. For example, to browse
content that were created between January 1 and January 4, you select January 1 as
the start date and January 4 as the end date. You must enter dates in yyyy/mm/dd
format or you click B and pick dates from a calendar.

Modified Date Specify a date range during which content were modified. For example, to browse
content that were modified between January 1 and January 4, you select January 1 as
the start date and January 4 as the end date. You must enter dates in yyyy/mm/dd
format or you click [ and pick dates from a calendar.

Search Click Search to send the search request to the Live server. More specific search
criteria return matching content more quickly.

Reset Filter Click Reset Filter to reset the existing search results and displays all the content on
the right panel.

Include Check Include Discontinued to include the discontinued content in the search result.

Discontinued  For an up-to-date list of content that have been discontinued, see the Discontinued
Content topic.

Search Results Panel

The Search Results panel displays search results based on the selections made in the Search Content
panel.

This is an example of the Search Results panel.

The following table describes the elements in the search results panel.

Fowrs  Despten

Name The name of the content. For example, Log Parser Pack.
Created The date when the content was created. For example, 04-Aug-2017 15:19:06,
Updated The date when the content was last updated. For example, 29-Sep-

2020 20:27:14.

Type The type of the content. For example, Bundle.
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Description

Min Platform Platform version that the content supports. For example, 11.5 and higher.
Version

Note: Min Platform Version is not applicable for Community content.

Description The description of the content. For example, Contains all parser files and log
collection files.

Discontinued The status of the discontinued content:
¢ Yes: The content that matches the search criteria is discontinued

¢ No: The content is not discontinued

Content Details Panel

In the Search Results panel, you can select any content titles to view the details in the pop-up window
and download the content.

Note: NetWitness provides no assurance related to the quality and accuracy of the content provided by
the third parties and open source communities.

This is an example of the Content Details panel.

Content Details

NOTE: The following content is collected and derived from third-party, open sources. RSA
[NetWitness] at no times makes claims to the quality and/or efficacy above and beyond the
attestations of the authors of the content itself.

[Community] Malware, Malicious Code and APT Open Source YARA
Rules

TYPE

Malware Rules

UPDATED

16-Feb-2022 21:40:00

DESCRIPTION

The following corpus of YARA rules focus on the detection, identification, and analysis of various forms and
types of malicious code & content (malware) and in some cases those threat actors/adversaries associated

with their use and proliferation. These YARA rules have been collected from the open-source community and

are being made available to our customers via our NetWitness Live Community capability.

Mediums

None

@ Large files may take longer time to start the download. Download

The following table describes the elements in the Content Details section.
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Name
Type
Created
Updated

Description

Version on
Production

Size
Required
Resources

Tags

Required
Meta Keys

Generated
Meta Values

Discontinued

The name of the content. For example, Log Parser Pack.

The type of the content. For example, Bundle,

The date when the content was created. For example, 04-Aug-2017 15:19:06.
The date when the content was last updated. For example, 29-Sep-2020 20:27:14.

The description of the content. For example, Contains all parser files and log
collection files.

The version of the content. For example, 0.5.

The size of the content. For example, 14.96 KB.

A list of resources on which this resource depends. For example, NetWitness Lua
Library. Clicking a resource replaces the currently displayed details with the details
of the one you clicked in the pop-up window.

The tags that apply to the content. For example, threat. Clicking a tag opens the
Live Search Content view with the search narrowed to match content with that tag.

The meta keys that apply to the content. For example, Threat Category. Clicking a
meta key opens the Live Search Content view with the search narrowed to match
content with that meta key.

The meta values that the content generates. For example, rsa-firstwatch. Clicking a
meta value opens the Live Search Content view with the search narrowed to match
content with that meta value.

The status of the discontinued content:
¢ Yes: The content that matches the search criteria is discontinued

¢ No: The content is not discontinued
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Resource Package Deployment Wizard

If you have created a package of resources and saved it on a network drive, you can use the Resource
Package Deployment Wizard to deploy the resources manually to a service or a service group without
subscribing to the resources. NetWitness accepts packages in .nwp files or .zip files.

Deploying resources manually deploys them directly to the services without taking advantage of the
powerful resource management capabilities of NetWitness.

If you want to receive notification and updates for updated resources and be able to easily remove
resources from a service, you must subscribe to resources in the Live Search view and deploy the
resources in the Live Configure view.

Note: Use NetWitness Live to create resource bundles; this is a different application that is not part of
NetWitness. Selecting Package > Create in the Live Search - Matching Resources toolbar displays
the Content Package Tool window. You can choose resources to include in a package and save the
package as a NetWitness Package File.

The required permission to access this view is Deploy Live Resources.

To access this view:

1. Goto (Configure) > Live Content.

A& Package ~

2. In the Live Search - Matching Resources toolbar, select > Deploy.

The Resource Package Deployment wizard is displayed.

Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel Next

Features

The Deployment Wizard has five tabs: Package, Resources, Services, Review and Deploy.
Use Close to exit before you complete the wizard.

When you complete the wizard, NetWitness returns to the Live Resources View.

Package Tab

You use this tab to select a resource bundle from your network in this page.

This is an example of the Package tab, with a resource bundle already selected.
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Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle resourceBundle3866217298122437775.zip Browse

Cancel Next

The following table describes the elements in the Package tab.

Resource The input field to specify a resource bundle. You can type a path in this field or search using the

Bundle rowWs
= = button.

Command Buttons

Browse This button opens a File Upload dialog in which you can browse the local file system and select a
bundle.

Cancel Cancels the deployment and closes the wizard.

Next Displays the next tab of the wizard.

Resources Tab

This tab displays the resources contained in the bundle.

The following figure shows an example of the Resources tab.

Resource Package Deployment
Package Resources Services Review Deploy
Total resources : 2

Resource Names Resource Type Dependency Of
suspicious php put long query RSA Application Rule

APT Domain Intelligence RSA Application Rule

Cancel Next

The following table describes elements in the Resources tab.

Resource Name Displays the name of the resources in the bundle (for example, NetWitness Lua Library).
Resource Type Displays the resource types for the resources in the bundle (for example, RSA Lua Parser)
Dependency Of Displays Resources on which the selected resource depends (for example, AIM lua),

Services Tab

You select the services on which you want to deploy the resources in the bundle.
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The Services tab has two tabs, Services and Groups. These provide a list of services and service groups

Q
that are configured in the (Admin) > Services view. The columns are a subset of the columns
available in the Services view. You can select the services or the service groups on which you want to
deploy the resources in the bundle.

This is an example of the Services tab.

Resource Package Deployment

Package Resources Services Review Deploy

O # Name ~ Type

Decoder
Decoder
Decoder

Log Decoder

O

Decoder
Log Decoder
Decoder
Decoder
Decoder
Log Decoder

Log Decoder

O O
W NN RN RN W WY

Decoder

Cancel Previous Next

The following table describes the elements in the Services tab.

Services
D Selects services on which you want to deploy the content. You can select any combination of services and
service groups.
Name Displays the services in your environment on which you can deploy the content.
Host Displays the name of the resource host.
Type Displays the type of NetWitness service.
Groups

D Selects service groups (if you have service groups defined in your environment).

Name Displays the names of the service groups.
Review Tab

Displays the resources and services on which the resources will be deployed.

In this tab, you can do the following:
e Review the content and services before you deploy.

e Initiate the deployment of the resources.

The following figure shows an example of the Review tab.
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Resource Package Deployment

Package Resources Services Review Deploy
Service Service Type Resource Name Resource Type
Decoder suspicious php put long query RSA Application Rule
APT Domain Intelligence RSA Application Rule
Cancel Previous Deploy

The following table describes the elements in the Review tab.

Service Information
Service Displays the services in your environment on which you can deploy the content.
Service Type Displays the type of each NetWitness service (type of host or service).
Resource Information

Resource Name  Displays the name of the resources you have selected (for example, NetWitness Lua Library),

Resource Type Displays the resource types for the resources you have selected (for example, RSA Lua Parser),
Deploy Initiates the deployment of the resources and displays the Deploy page (final page of the wizard).
Deploy Tab

This tab allows you to do the following:
* View the progress of the job
¢ Cancel the job

This is an example of the Deploy tab.

Resource Package Deployment

Package Resources Services Review

Service Name Resource Name Status Progress

Oof2

Cancel

The following table describes the elements in the Deploy tab.

N

Service Name of the services to which resources are deployed.
Name

Resource Name of the resources.

Name
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Status Status of the manual deployment.

Progress Progress of the manual deployment in a progress bar. When complete, the bar turns solid green.

Command Buttons

Close Closes the wizard.
Errors Only displays if NetWitness encountered any errors. Click to display the errors.
Retry Only displays if NetWitness encountered any errors. Click this button to try to deploy the resources

again using the wizard.
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NetWitness Live Registration Portal

The NetWitness Live Registration Portal is a self-service wizard in which customers can set up a Live

account and change or reset the password. A Live account is required to get access to the feeds, parsers,

rules, and other content in NetWitness Live library. To access the portal, go to the following
URL: https://live.netwitness.com/registration/.

NETWITNESS

Sign Up for Netwitness Live Account @

First Name

CREATE ACCOUNT

Click Sign Up For Live. The License Agreement page is displayed, once you agree to the Terms and
Conditions, click Accept: the fields for setting up an account are displayed. These include Contact
Information, and License ID.

The following table lists the contact information section fields and its descriptions:

First Name Your first name.

Last Name Your last name.

Company The name of your
company.

Email The email address

where you want to
receive notifications
related to the Live
account.
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License ID This is the License ID

on the (Admin)

> System > Info
page.

Caution:

The license ID on
the NetWitness
must be valid and
must be registered
on the Flexera
Server. If not,
contact NetWitness
Customer Support.

Username The username used to
sign in to Cloud
Services Live
account. The
username must
contain a minimum of
four characters and a
maximum of 16
characters.

Password The password for the
Cloud Services Live
account. The
password must
contain minimum of
eight characters and
the maximum length
is 24, with at least
one uppercase, one
lowercase, one
number, and one
special character.
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NetWitness Feedback and Data Sharing

The Live Feedback Activity Log enables you to download the usage data required for Live Feedback.
After you download the Live Feedback data, you can then upload it to share with NetWitness.

QA
The settings for these features are available in (Admin) > System > Live Services view,

in the Additional Live Services section.

Additional Live Services

Q
Participation in the Additional Live Services is configured in the (Admin) > System > Live
Services view.

Live Feedback

Note: For NetWitness 11.4.1 and later, this section in the UI has been removed. As of 11.4.1,
NetWitness has created the Customer Experience Improvement Program. For details, see "Configure
the Customer Experience Improvement Program” in the NetWitness System Configuration Guide.

Live Feedback is intended to help improve NetWitness.

Aoditional Live Services
Live Feedback

R5A collects details about the services you use in your deployment for new features and other improvements to the

platform. Informaticn collected is securely sent to RSA.
[ Additional Feedback Insights
B

Send additional information te improve feature usage, Learn maore

Once you set up and configure a Live account, usage data is automatically shared with NetWitness and is
protected in accordance with the applicable license agreement. All such data shall be anonymized and
shall not have any Personally Identifiable Information.

Before data is sent to NetWitness, all Personally Identifiable Information is removed. Thus, only
anonymous usage data gets transferred to NetWitness.

For more information, see the "Live Feedback Overview" topic in the System Configuration Guide.

File Reputation

File Reputation service provides instant access to the latest signatures using the RSA Live feed so data is
more relevant, with fewer false positives. With this service, users always have reliable data about the
reputation of files in their NetWitness Endpoint system. In addition to the whitelisting service, it
provides blacklisting information as well.
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File Reputation

[+ Enable File Reputation 7 Not Connected
This option is used to view reputation status of files. The File Hash information from NetWitness Platform is sent to
R5A Live to get the reputation status. Reputation status is leveraged by analysts during investigation of files,.Learn
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Troubleshooting Live Services

This section provides troubleshooting instructions for issues faced when using the Live Services module
in NetWitness.

Some Rules Are Invalid for Version 11.x

The rules "NetWitness Incident Management - Alert Details" and "NetWitness Incident Management -
Incident Summary" are not valid for NetWitness version 11.x. Do not deploy these rules to an 11.x
system.

Note: Rules are updated frequently, and the documentation for them is available in the Content space
on NetWitness Community. For the latest information on Rules, see RSA NetWitness Rules.

OutOfMemoryError on Context Hub Server

You may encounter an OutOfMemoryError on Context Hub server, and the service becomes
unresponsive.

If there are any TAXII feeds configured, Health and Wellness raises alerts when the available heap
memory of Context Hub server is critically low. If the status of Context Hub server is Unhealthy because
of low memory, perform the following steps:

1. Make sure that the feeds Start Date is within 180 days.

2. Check if any TAXII feed is consuming too much disk space. A TAXII feed can consume maximum
of 300 MB. If it consumes more disk space, you must reduce the value in the Remove STIX data
older than field under Advanced Options in the Custom Feed Creation Wizard when you edit a
TAXII feeds.

Note: If the issue still persists, you must execute step 3.

3. To decrease the number of parallel threads available for processing STIX:

a. Goto K& (Admin) > Services > Context Hub service > View > Explore.
b. In the tree panel, navigate to enrichment/stix/ config.

c. In the right panel, set the stix-query-scheduler-pool-size field value to 2. By default the value is
5. This setting controls how many number of threads are allowed to process queries for STIX
data at the same time.

d. Set the taxii-poll-scheduler-pool-size field value to 2. By default the value is 5. This setting
controls how many number of threads are allowed to poll TAXII servers at the same time.

e. Restart the Context Hub server.

Troubleshooting Live Connect Threat Data Sharing
This section discusses troubleshooting Live Connect Threat Data Sharing.
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Query Log Retrieval Sample

To retrieve a sample of threat intelligence data sent to Live Connect, you must construct a URL by
setting the following parameters:

¢ sendReport: value is true or false: true to send this report to the Live Connect server. False to
just create the report for viewing. The value defaults to false.

¢ hashValues: value is true or false: true to hash the values as md5/sha256. False to show values in
clear text — should use only for manual viewing. Defaults to false.

o startDate / endDate: Dates for time boundaries for log entries. Format: YYYY-MM-DD
HH:mm:ss

The following is an example of the URL used to retrieve query logs:

https://<server>/admin/liveconnect/force aggregation?startDate=2016-01-
18%2000:00:00&endDate=2016-01-19%2010:10:00&sendReport=false&hashValues=true

System Logging: Debug

To access debug information:

a4
1. Goto (Admin) > System > System Logging.
2. Select the Settings tab.

3. In the Package Configuration section, select com > netwitness > platform > server >
liveconnect > service (DEBUG).
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Info

System Logging

Updates -
Realtime Historical setings

Licensing
Ernail Package Configuration

Global Motifications @[ investigation

Legacy Motifications B[ list
B ]lve

B 5 liveconnect

I System Logging

Global Auditing

B service (DEBUG)
Jobs

U LiveConnectClient

Live Services

i LiveConnectloghggregatarService

URL Integration i LiveConnectLogParserService
Context Menu Actions ¥ LiveConnectlogRetrievalService
B malware

Investigation

HTTP Proxy Settings

Package com.rsasmecsaliveconnectservice
NTP Settings Log Level DEBUG v
Dashboard Settings [[] Reset recursively

2 admin | @B English (United States) | GMT+00:00
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